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.­ 1. Introduction 

The coiled-tubing stress analysis (coiled-tubing stress/drag/hydraulic/buckling) windows applications 

program (CSTRESSl) has been developed by Maurer Engineering Inc. as part of the DEA-67 project 

to "Develop and Evaluate Slim-Hole and Coiled-Tubing Technology." This program, coded in Visual 

Basic 1.0, is written for use with IBM or IBM compatible computers and must run with Microsoft 

Windows 3.0 or later version. 

1.1 MODEL DESCRIPTION 

CSTRESSl is an integrated computer program of drag force, hydraulics, buckling, and triaxial 

stress analysis. It is a major rewrite of the coiled-tubing model, not just an update. The features of 

CSTRESSl are listed below. 

1.1.1 General Features 

1. 	 MS Windows applications. 

2. 	 Five operations: pick up (logging), slack off (logging), pick up (drilling - tripping), 
slack off (drilling - tripping), and drill. 

3. 	 Supports both color and monochrome monitors. 

4. 	 Supports English and metric unit systems. 

5. 	 Handles up to fifteen tube segments and twenty well intervals. 

6. 	 Coiled-tubing and casing data can be imported from the built-in data base file directly. 

7. 	 Enables the user to modify the data base within the program. 

8. 	 Allows input of pore and fracture pressures for different well interval. 

9. 	 Results, data and graphs, can be output to screen, printer, and disk file. 

10. Selectable curves on output graphic presentation. 

1.1.2 Drag Force. Axial Load. and Triaxial Stress 

1. 	 Computes axial drag on coiled-tubing during pick up, slack off, and drilling. 

2. 	 Computes axial load and stress on coiled-tubing during pick up, slack off, and drilling. 
The axial load and stress is based on tubing pressure, annulus pressure, pipe weight, 
and frictional force. 

3. 	 Bending stress (based on dogleg or helical buckling curvature) can be included in the 
calculation. 

4. 	 Extra frictional force caused by helical buckling can be included in the calculation. 

5. 	 Calculates triaxial stress and has both graphics and text output. 

6. 	 Calculates allowable working stress and pressure for biaxial and API stress criteria 
with graphic output. 

7. 	 Calculates maximum cable load. 

-
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1.1.3 Hydraulics 

I. 	 Calculates internal and external pressures on the tubing at various locations during 
tripping and drilling. 

2. 	 Calculates bottom-hole pressure and ECD during tripping. 

3. 	 Calculates ECD corresponding to the total pressure along the wellbore. 

4. 	 Plots pore and fracture pressures along the wellbore (optional). 

5. 	 Calculates pressure loss of the coiled tubing remaining on the reel. 

6. 	 Calculates the required pump horsepower. 

1.1.4 Buckling 

I. 	 For compressive loads, the onset of I) sinusoidal buckling, 2) helical buckling, and 3) 
limiting yield stress are indicated. 

2. 	 Two sinusoidal buckling criteria can be evaluated: 1) Exxon's equation, and 2) Texas 
A&M University's equation. 

3. 	 Two helical buckling criteria can be evaluated: I) Rice University's equation, and 2) 
Texas A&M University's equation. 

1.1.5 Tortuosity 

I. 	 Survey data can be "tortured" (add tortuosity along the trajectory of wellpath). 

2. 	 Allows insertion of equally spaced stations to survey data. 

3. 	 Different tortuosity amplitude and cycle lengths can be applied up to five wellpath 
intervals. 

1.2 COPYRIGHT 

Participants in DEA-67 can provide data output from this copyrighted program to third parties and 

can duplicate the program and manual for their in-house use, but will not give copies of the program or 

manual to third parties. 

1.3 DISCLAIMER 

No warranty or representation is expressed or implied, with respect to these programs or 

documentation, including their quality. performance, merchantability. or fitness for a particular purpose. 

1-2 




-
 2. Theory and Equations 

2.1 	 AXIAL DRAG 

The drag model is based on a simple mathematical model, developed by Exxon Production 

Research (Johancsik et al., 1984). The model assumes the loads on the tubing result solely from effects 

of gravity and frictional drag resulting from contact of the tubing with the wall of the hole. These 

frictional forces are the products of the normal force acting between the tubing and the wellbore and the 

coefficient of friction (friction factor). Two contributions to the normal force are considered for this 

model: l) the effects of gravity on the tubing and 2) the effects of tension and compression acting 

through curvatures in the wellbore. Although bending may make minor contributions to normal force, 

its effect is neglected in this model. 

The model considers the tubing to be made up of short segments joined by connections which 

transmit tension, compression and torsion, but not bending moment. The basic equations of friction are 

applied to each segment with the calculations starting at the bottom of the tubing and proceeding upward 

to the surface. Each short element thus contributes small increments of axial drag and weight. These 

forces are summed to produce the total loads on the tubing. For this version of CSTRESS, torsion is 

- not taken into consideration. 

2.1.1 	Introduction to the Variables 

Figure 2-1 is a simple free-body diagram of a single element of the tubing. 

Figure 2-1. Free-Body Diagram of a Single Element 
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where: 

f = Friction Factor 

F = Axial Friction Force 

M Torque = 0 for Coiled Tubing 

N = Normal Force 

T Tension 

R = Effective Radius of Element 

WTM Buoyancy Weight of Coiled Tubing or Weight in Mud 

WcM Buoyancy Weight of Loose Cable in Coiled Tubing 

8 = Inclination Angle 

7J = Average Inclination Angle 

"' = Azimuth Angle 

.6. Incremental Values 

2.1.2 	 Derivation or the Equations 

When a loose cable is suspended inside the coiled tubing, the weight of the cable is 

suspended by the reel while the weight of the tubing and frictional drag are suspended by the injector 

head (hook load). Therefore, the weight of the cable effects the weight term in the normal force equation 

(Eq. 2-1), but does not effect the weight term in the tension increment equation (Eq. 2-2). 

In analyzing each segment, the first requirement is to calculate the magnitude of the 

normal force, N, as follows: 

(2-1) 

The tension increment is then calculated as follows: 

.6.T " WTM cos7J ± F (2-2) 

F "fN (2-3) 

or .6.T " WTM cos7J ± fN 
(2-4) 

In this equation, the plus sign is used for upward motion (meaning axial drag adds to the effect 

of gravity), and the minus for downward motion (meaning axial drag subtracts from the effect of gravity). 

2.1.3 	 Consideration or Multi-Element Cases 

As the calculation procedure takes place, T + .6.T becomes T for the element above the 

present calculation point and .6.T contributes to the overall sum. When completed, the analysis yields 

tensile loads as functions of depth along the string. 
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2.2 	 APPL YING THE DRAG MODEL TO A STRING OF COILED TUBING - To apply the mathematical model in the stepwise fashion as shown earlier, it is necessary to 

specify the following information for each element: 

1. Physical size and weight 
2. Spatial orientation 
3. Nature of motion 
4. Tensile load at the bottom of the element 
5. Friction factor 

The following paragraphs discuss each of these and relate them to tubing design or operational 

parameters, whichever is applicable. 

2.2.1 	 Physical Size and Weight 

One aspect of physical size is the length of the element. When a stepwise solution is 

applied, this will be the size of each "step" as the solution process marches up the tubing. The outside 

and inside diameters of the elements are needed to calculate stress and buckling criteria. These are 

obtained from a physical description of the tubing. The weight of the element, adjusted for the effects 

of buoyancy, is part of the tensile force balance. 

2.2.2 	 Spatial Orientation 

Spatial orientation refers to the values for inclination and azimuth angle at both ends of- the element. These can be obtained from weHbore survey information. 

2.2.3 	 Nature or Motion 

The nature of the motion is necessary to determine what effect the drag force has. If the 

string is moving up, the drag force adds to the weight component of tension. When downward motion 

is present, the drag force subtracts from the weight component. 

In terms of actual operations, upward motion occurs when raising the string of tubing 

(i.e., picking up or coming out of the hole). Downward motion corresponds to lowering the string (i.e., 

slacking off, drilling, or going in the hole). 

2.2.4 	 Loads at the Bottom or Each Element 

The tensile drag at the lower end of the element must be known prior to calculation of 

the element. Remember, the model takes the increment of tension due to drag and weight and adds this 

to the tension value found at the lower end of the element. However, this information does not have to 

be supplied for every element because the model uses the value calculated for the upper end of the 

current element as the initial value for the lower end of the next element. Thus, the boundary conditions 

of the tensile drag at the bottom of the string are all that must be provided. 

2-3 




The values used for boundary conditions at the bottom of the coiled-tubing string will 

depend upon the operation being simulated. When the string is going into the hole, (slack off or drill), 

the bottom of the string is in compression. When the string is coming out of the hole, the bottom of the 

string is in tension. The following are the factors that affect bottom boundary conditions for each 

operation being simulated. 

1. Pick up (logging): Consists of logging tool weight and bottom tool drag. 
2. Slack off (logging): Consists of logging tool weight and bottom tool drag. 
3. Pick up (drilling, tripping): Consists of bottom tool drag. 
4. Slack off (drilling, tripping): Consists of bottom tool drag. 
5. Drill: Consists of bottom tool drag and weight-on-bit. 

2.2.5 	 Loads at the Too or the Coiled Tubing 

Stuffing box drag is a load applied both during pick up and slack off. It simulates the 

frictional drag in the seal of a stuffing box or lubricator. It has no effect on the tension loading of the 

tubing below the stuffing box. It increases tension in the tubing above the stuffing box during pick up 

operations and decreases tension when slacking off. 

Coiled-tubing reels keep a constant back tension on coiled-tubing which is called pick-up 

reel back tension and slack-off reel back tension. This back tension reduces the load read on the 

transducers at the injection head. The back tension is always in the same direction, whereas friction in 

the stuffing box gland changes direction from pick up to slack off. 

2.2.6 	 Friction Factor 

The friction factor is a very important number because it is the one parameter that char­

acterizes the surface-to-surface interaction central to the mathematical model. A great amount of work 

has gone into obtaining and verifying values of friction factor for predictive work. A few comments at 

this point will facilitate a better understanding of the application of friction factors to coiled tubing. The 

exact value of the friction factor applicable to a situation is a function of many things, including drilling 

fluid type and composition, formation type (in open hole), casing material and condition (in cased hole), 

and tubing material and condition (e.g., roughness). At a single point in time, the mud type and 

composition in the well are constant but significant changes may be taking place in portions of both cased 

and open hole. Thus, in certain cases, it may be necessary to use two friction factors, one for the 

tubing/casing interaction and one for the tubing/formation interaction. 

2.2.7 	 Cable Load 


The maximum tensile cable load, Tc, at the top of the cable equals: 


Tc 	 (2-5)TVDcable X W c 
where: 

Tc Maximum Cable Tensile Load 

Maximum TVD of CableTVDcable 


WC Cable Buoyed Weight 


This tensile load is supported by the reel and not by the injector head. 
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2.3 	 AXIAL STRESS AND LOAD

The torque and drag model mentioned previously considers only the effects of mechanical force 

or drag force. It does not consider compressive loads imposed on the tubing string as a result of 

hydrostatic pressure. The model gives correct results for torque and drag and buckling calculations but 

not for mechanical strength failures an:! burst an:! collapse estimales. Therefore, load contribution due to 

hydraulic pressure must be coffiidered. 

2.3.1 	 Load at Bottom 

A hydrostatic or buoyant compressive force acts on the bottom of the tube. This force 

is caused by the hydrostatic pressure in the liquid at the bottom of the hole. The magnitude of this force 

is given by 

Fhb ?r ( = - Pob x OD 2 - Pib x ID 2) 	 (2-6)
4 

Fhb Compressive load acting on the end of the tubing string 

Pob = Bottom tube annual pressure 

Pib Bottom tube inside pressure 

OD Bottom tube outside diameter 

ID Bottom tube inside diameter 

When hydraulic force combines with logging tool weight, BHA drag, or weight-on-bit 

it becomes bottom-boundary load. 

2.3.2 	 Axial Load 

To calculate axial load, you would modify Eqs. 2-2 to 2-4. Since hydrostatic pressure 

is considered in the bottom-boundary load, the buoyancy force should not affect pipe weight contribution 

in the axial direction. For normal force (lateral side load), buoyancy must be considered. In analyzing 

each segment, Eqs. 2-I to 2-4 become: 

-

-

- (2-7) 

It is the same as Eq. 2- I, the tension increment is calculated as follows: 

1>Ta=WT • cos1J±F 	 (2-8) 
a 

F = f N or (2-9) 

"'Ta = WT • cos 1J ± f N (2-IO) 
" 
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where: 

A Ta Axial load (tension) increment 


WTa = Tubing weight in air 


N = Normal force 


f = Friction factor 


F Axial friction force 


2.3.3 	 Hook Load 


Hook load measured at the injector head equals: 


Hook Load (Pick up) = Tp + F0 - FR 


Hook Load (Slack oft) = Ts - F0 - FR 


Hook Load (Drill) = TD - Fo - FR 


where: 

Tp = Pick-up Tensile Tubing Load below Stuffing Box 

Ts Slack-off Tensile Tubing Load below Stuffing Box 

To = Drill Tensile Tubing Load below Stuffing Box 

Fo = Stuffing Box Drag 

FR = Reel Back Tension 

This hook load is applied to the tubing by the injector head. The hook load does not 

include the force to support the cable since the cable is supported by the reel and not by the injector head. 

2.3.4 	 Axial Stress 

Axial stress without bending stress which is exerted by wellbore dogleg or helical 

buckling is: 

O'a = Ta I cross section area or (2-11) 

(2-12) 


where: 

ua = Axial stress 

Ta = Axial load 
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2.3.5 Axial Load and Axial Drag -

ID . 

OD-. ~ 

Pib 
...... 

Pob 

FORCE 

AXIAL LOAD 
(USE WBGHT IN AIR 
TO CALCULATE) 

0 

AXIAL DRAG 
(USE BUOYNACY WEIGHT 
TO CALCULATE) 

HYDRAULIC /::TICAL DEPTH 
PRES SU RE ACT AT 
BOTIOM 

Figure 2-2. Compare Axial Load and Axial Drag 

Shown in Figure 2-2 is a steel tube in water. At the bottom of the tube, the inside and 

outside pressures are equal. Axial load curve and axial drag curve that intersect at water level can easily 

be found. For axial drag calcuJation, tube buoyancy weight (weight in water) is used. For calcuJating 

axial load, weight in air and hydraulic pressure at the bottom of the tube are used. 

2.4 BENDING STRESS 

Bending stress can be exerted by either wellbore dogleg or helical buckling. The bending stress 

from dogleg is shown below: 

uDL = ('ll' • E • DL • OD) /432000 (2-13) 

where: 

uDL Bending stress exerted by dogleg (psi) 

E = Elastic modulus (psi) 

DL = Dogleg ( 0 /HJO ft) 

OD Tube outside diameter (in.) 

If the tubing is in helical bending, the path of tubing is not only following the wellbore, but is 

also following the spiral shape (Lubinski et al., "Helical Buckling of Tubing Sealed in Packer" Journal 

ofPetroleum Technology, June, 1992). The pitch of helical buckling can be estimated due to axial drag. 

After the pitch is obtained, the curvature of the tube with helical buckling can be found. 

r Clearance 

P Pitch of helical buckling 

k = Curvature of the tube with helical buckling 

uhel Bending stress due to helical buckling 
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E = Elastic mcxlulus 

I = Moment of inertia 

HID = Hole diameter 

T Axial drag 

OD = Tube outside diameter 

(2-14) 

HID - OD (2-15)r "' 2 

4~r (2-16)k"'----­
p2 + 4~82 

E • k • 	OD (2-17)
2 

p"' 

uhel is the helically buckled tube's bending stress, so in the helical buckling section of coiled 

tubing, the bending stress will be uhel (Eq. 2-17) rather than unL (Eq. 2-13). 

2.5 HYDRAULICS ANALYSIS 

The mcxlels most commonly used in the drilling industry to describe fluid behavior are the 

Bingham plastic and power-law mcxlels. They can be used to calculate frictional pressure drop, swab 

and surge pressures, etc. The hydraulic calculation in CSTRESS 1 is based on equations derived in 

Applied Drilling Engineering (Bourgoyne et al., 1986) and API SPEC 10. The more sophisticated 

Herschel-Buckley mcxlel has not been included in this program because of lack of experimental data, but 

it will be considered in the future version. 

2.5.1 	 Bingham Plastic Model 

The Bingham plastic mcxlel is defined by Eq. 2-18 and is illustrated in Figure 2-3. 

(2-18) 
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0 
" ·>-­

I SHEAR RATE' y 

~-~ 

-


where: 

ry = Yield stress 

l'-p Fluid viscosity 
r = Shear stress 

i' Shear rate 

Figure 2-3. Shear Stress Vs. Shear Rate for a Bingham Plastic Fluid 
(Bourgoyne et al., 1986) 

As shown in Figure 2-3, a threshold shear stress known as the yield point (ry) must be 

exceeded before mud movement is initiated. 

The mud properties l'-p and "Y are calculated from 300- and 600-rpm readings of the 

viscometer as follows: 

= 
(2-19) 


where: 


= shear readings at 600 and 300 rpm, respectively. 
8600 , 8300 

Calculation of frictional pressure drop for a pipe or annulus requires knowledge of the 

mud flow regime (laminar or turbulent). 

1. Mean Velocity 

The mean velocities of fluid are calculated by Eq. 2-20 and 2-21. 

For pipe flow: 

Q
v = ----=- (2-20) 

2.448d2 
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For annular flow: 
Q 

v = -----­

2.448 ( <li _dn (2-21) 

Where: 

v 

Q 

d 

d1 
d1 

= 

= 
= 
= 

Mean velocity, ftfsec 

Aow rate, gal/min 

Pipe diameter, in. 

Casing or hole ID, in. 

Drill string OD, in. 

2. Hedstrom Number 

prediction. 

The Hedstrom number, NHE, is a dimensionless parameter used for fluid flow regime 

For pipe flow: 

NHE = (2-22) 

For annular flow: 

24,7()() p Ty (d2 - di)2 

2 
J.Lp 

(2-23) 

Where: 
p = Mud weight, lb/gal 

3. Critical Reynolds Number 

flow. The 

Figure 2-4. 

The critical Reynolds number marks the transition from laminar flow to turbulent 

correlation between Hedstrom number and critical Reynolds number is presented in 

The data in Figure 2-4 have been digitized in the program for easy access. 
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Figure 2-4. Critical Reynolds Numbers for Bingham Plastic Fluids 

(Bourgoyne et al., 1986) 


4. Reynolds Number 

Reynolds number, NRe• is another common dimensionless fluid flow parameter. 

For pipe flow: 

928pvd (2-24)NRe = -- ­
1'-p 


For annular flow: 


757 p v(d2 - d1) 
 (2-25)NRe = ----- ­
1'-p 

5. 	Frictional Pressure Drop Calculation 

For pipe flow, the frictional pressure drop is given by: 

(1) Laminar flow (NRe < Critical NRe) 

Ty+ 	 __ (2-26) 
225d 

(2) Turbulent flow (NRe ~ Critical NRe ) 

dPr _ fpv 2 (2-27) 
dL - 25.Sd 

where f is the friction factor given by 
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(2-28)Jl = 4 log (NRelf) - 0.395 


For annular flow, the frictional pressure drop is: 


(1) Laminar flow (NRe < Critical NRe ) 

dPf = P-pV + Ty 

dL -1000~-(-d2___d_1~) ~~~- (2-29)
2 

200 ( d2 - di) 

(2) 	 Turbulent flow (NRe ~ Critical NRe ) 


dPr _ fpv2 
 (2-30) 
dL - 21.1 (d2 -di) 

where f is determined using Eq. 2-28. 

2.5.2 	 Power-Law Model 

The power-law model is defined by Eq. 2-31 and illustrated in Figure 2-5. 

ere: 

K = Consistency index, equivalent centipoise (see Bourgoyne et al., 1986) 

n = Flow behavior index, dimensionless 

(2-31) 

wh

SHEAR RATE, "f 

T = Ky Iti
n - I 

Figure 2-5. Shear Stress Vs. Shear Rate for a Power-Law Fluid (Bourgoyne et al., 1986) 

The fluid properties n and K are calculated as follows: 
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6300 

K = 510 6300 (2-33) 
511" 

The critical Reynolds number must be determined before the frictional pressure drop 

can be calculated. 

1. 	 Mean Velocity 


For pipe flow: 


v = __Q..;:_~ (2-34) 
2.448d 2 

For annular flow: 

v = ____;:Q::...__....,. 
(2-35) 

2.448 (di _ dn 

2. 	 Critical Reynolds Number 

The critical Reynolds number can be read from Figure 2-6 for a given flow 

behavior index n. 

.­

Figure 2-6. Friction Factors for Power-Law Fluid Model (Bourgoyne et al., 1986) 

The data in Figure 2-6 can be approximated by the following (Leitao et al., 1990): 

Critical NRe = 4200 for n < 0.2 

Critical NRe = 5960 - 8800 n for 0.2 ~ n ~ 0.45 (2-36) 

Critical NRe = 2000 for n > 0.45 
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3. 	 Reynolds Number 


For pipe flow: 


89,lOOp v 2 
< -n) [ 0.0416 d] 0 

NRe = K 3 + l/n 

For annular flow: 

N = 109 ,OOOp V(2-n) [ 0.0208 (d2 - d1)] n 

Re K 2 + l/n 

4. 	 Frictional Pressure Drop Calculation 

For pipe flow: 

(1) 	 Laminar flow: (NRe < Critical NRJ 

0 
dPf Kv 0 

[ 3 + l/n] 
dL = 144,000 d (1 +n) 0.0416 

(2) 	 Turbulent flow (NRe ~ Critical NRJ 

dPr _ fpv 2 

dL - 25.8d 

where the frictional factor f is given by: 

_4.0 	I (N f(l-n/2)) _ 0.395 ---og Re - ­
n0.75 	 nl.2ff 

For annular flow: 

(1) 	 Laminar flow: (NRe < Critical NRJ 

Kv0 	 0
dPr [2 + l/n] 
dL = 144,000 (d - di)'l+n) 0.0208

2 

(2) Turbulent flow (NRe ~ Critical NRJ 

dPr fpv 2 

dL 21.1 (d2 -di) 

where f is calculated using Eq. 2-41. 

(2-37) 

(2-38) 

(2-39) 

(2-40) 

(2-41) 

(2-42) 

(2-43) 

2.5.3 	 Bit Pressure Drop 

There are three assumptions made to calculate bit pressure drop: 

I. The change in pressure due to change in elevation is negligible. 
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1 
2. Upstream velocity is negligible compared to nozzle velocity. 

3. Frictional pressure drop across the nozzle is negligible. 

Nozzle velocity equals 

Qv =.,,......,~- (2-44) 
n 3.117 AT 

where: 


V n = Nozzle velocity, ft/sec 


Q = Flow rate, gal/min 


AT = Total nozzle area, in.2 


and bit pressure drop equals 

(2-45) 

where: 

Cd = discharge coefficient factor (recommended value = 0.95) 

(Bourgoyne et al., 1986) 

The hydraulic horsepower (HHP) and the impact force (F;) at the bit are -
HHP = dPbQ (2-46) 

1714 

(2-47) 

The total pressure drop in the system equals: 

(2-48)Ptotal = E Pp+ E Pa+ dPb 

Where: 

E PP = Summation of pressure losses inside the pipe 

E Pa = Summation of pressure losses in the annulus 

Therefore, the pump horsepower (PHP) is 

PHP = Ptotal _g_ (2-49) 
1714 

where: 

·-- surface equipment pressure loss, psi 

flow rate, gal/min 
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2.S.4 	EauivaJent Circulating Density 

Of particular importance is the equivalent circulating density (ECD) at a certain depth. The 

ECD is the density of fluid that will produce the same hydrostatic pressure as the circulating presmire 

at that point (bottom of the hole) i.e., 

p
ECD 	= 0 (lb/gal) (2-50)

0.052 x TVD 

where: 

P0 = Pressure at the point, psi 

TVD True vertical depth at the point, ft 

2.6 	 SURGE AND SWAB PRESSURES 

Equations 2-26 through 2-30 and 2-39 through 2-43 have been presented for frictional pressure 

drop calculation, the first set for a Bingham plastic fluid and the second for a power-law fluid. These 

models can also be applied to determine surge and swab pressures if the running speed of the drill pipe 

is known. Surge pressure is the pressure increase caused by lowering pipe into the well. Pressure 

decrease, resulting from withdrawing pipe from the well, is called swab pressure. 

For a closed pipe, the estimated annular velocity is (Moore, 1974): 

(2-51)v = 

where: 

vp Pipe running speed, ft/min 

v Average annular fluid velocity, ft/min 

K = Clinging constant (recommended value = 0.45). 

Moore suggested using maximum fluid velocity to take into account the acceleration and 

deceleration of the pipe. In general, the maximum fluid velocity equals: 

(2-52)vm = 1.5v 

Surge and swab pressures are calculated by substituting maximum fluid velocity for mean velocity 

in the previously presented frictional pressure drop equations. 

Of particular importance is the equivalent circulating density (ECD) due to surge and swab 

pressures. The calculation of ECD can be performed using Eq. 2-50. 
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2.7 BUCKLING THEORY 

The compressive loads required to initiate the onset of sinusoidal, helical, and spring 1heory 

buckling are indicated on the graphic output of the slack-off plots. The significance of these three stages 

of buckling is as follows: 

2.7.1 	 Sinusoidal Buckling 

As compressive force is increased on a length of tubing lying along the bottom of an 

inclined hole, a point is reached where the tubing will assume a sinusoidal configuration along the bottom 

of the hole (Figure 2-7). The critical force required to achieve this is calculated using either the Exxon 

formula presented in Eq. 2-53 (Dawson and Paslay, Jourrwl Petroleum Technology, October 1984, 1734 

- 1738) or the Texas A&M University formula presented in Eqs. 2-55 - 2-57 (Wu and Juvkam-Wold, 

ASME Paper 93-PET-7). 

where: 

Critical axial load to begin sinusoidal buckling, lbf Fcsin 

E Elastic modulus, psi 

I = Moment of inertia of tubing cross section, inches4 

r = Radial clearance between tubing and borehole, inches 

6 = Inclination of hole, degrees 

1J = Average inclination of hole section, degree 

wmud = Unit pipe weight in mud, !bf/in. 

R = Radius of the curvature, in. 

In Exxon's equation, if the inclination angle is zero, then the sinusoidal buckling critical 

load is zero. In the program CSTRESS, if the inclination is less than 3°, the program uses 3° instead 

of the inclination (Eq. 2-54). 

Exxon 
112 

E • I•Wmrud ·Sin (9) ] (2-53) 
Fcsin = 	2 (for 6 >3°)[ 

Exxon 
1/2 

_ E • I• Wmud •Sin (3) (2-54) 
Fcsin - 2 (for 6 <" 3°}[ r l 

For the vertical, slant, and curved sections, A&M uses three equations for each situation 

to find the critical buckling load. 
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18000R = x 12 
'll' • DL 

A&M 


( 2 )1'3 (2-55)
Fein= 0.85 E •I• Wmud ( for vertical) 

A&M 

12 
[ E • I • W ~ud • sin (IJ)] 1 (2-56)

Fcsin = 2 • (for slant) 

A&M 

(2-57)4 • E •I 
Fcsin = (for curved)[I• [I• "R'·~;~·••(Uf']

r • k 

(2-58)

Figure 2-7. Sinusoidal Buckling 

2.7.2 Helical Buckling 

If the axial compressive load is increased beyond the point where sinusoidal buckling 

occurs, helical buckling will eventually result. In helical buckling, the tubing forms a helix along the 

wall of the hole, the pitch of the helix decreasing as compressive load increases (Figure 2-8). 
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Figure 2-8. Helical Buckling 

The critical force required to achieve helical buckling is calculated using either the Rice 

University formula presented in Eq. 2-59 (Chen, Lin, and Cheatham, 1989, "An Analysis of Tubing and 

Casing Buckling in Horiwntal Wells," OTC 6037) or the Texas A&M University formula presented in 

Eqs. 2-61 - 2-63 (Wu and Juvkam-Wold, ASME Paper 93-PET-7). 

Rice 

112 
(2-59)E ·I· Wmrud • sin(U)]

Fchel = 2 •.fl • (for () > 3°)[ 

Rice 

112 
r:;- [ E • I • Wmud •sin (3) ) (2-60)

Fhl =2•y,;.. (for () < = 3°)
c e r-

A&M 

2 )1/3 (2-61)
Fchel = 2.85 ( E •I. Wmud ( for vertical) 

A&M 

In 
E ·I · W • sin (2-62)

Fchel = 2 ( 2 • .ff - 1) ~ud (U) (for slant)[ ] 
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A&M 

Fchel 
12 • E • I 

r • R 
+ 4 • E • I ___ 

r•R [4 • [ l + 
r • R 2 • Wmud • sin (11)] 11 

2 

-----=-=-c---­
8 EI 

(2-63) 

112]+ 	 r·R2 ·Wmud·sin(1J) 

4 • E ·I l
From Exxon's and Rice's formulas (Eqs. 2-53 and 2-59), helical buckling begins when the 

axial compressive force is l.414 (/f) times the value of sinusoidal critical buckling load. 

2.7.3 	 Suring Theory Buckling 

If compressive axial load is increased beyond that required to initiate helical buckling, the 

pitch of the helix decreases until a point is reached where the shear stress loading of the tubing will equal 

its minimum yield shear stress (Figure 2-9). This is calculated using Equation 2-64 which is based on 

the theory of helical springs under compression. (See A.M. Wahl, "Mecha.nical Springs," 2nd edition, 

McGraw Hill Book Company, New York, 1963.) 

t'll'd 2 

(2-64) 

where: 

Fcspr = Critical force required 1o ~ maximum shear 1o equal minimum yield shear, lbs 

d = Tubing diameter, inches 

D = Hole diameter, inches 

Minimum yield in shear, psi. This is equal to half of the tensile yield. 

F 

(a) 

(a) AJ:i.aUy loaded helical spring; (b) free-body d'3gum showing that the wire ;, 
su bjcctcd to a. direct shc.21" a.nd a. ton:ional ihar. 

Figure 2-9. Axially-Loaded Helical Spring 
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2.7.4 Which One Do I Use? -
 As indicated above, the smallest critical force is Pesin• the critical compressive force 

required to initiate sinusoidal buckling. Next largest is F chel• the critical compressive force to change 

from sinusoidal to helical buckling. The largest of the three critical forces is F cspr• the axial force 

required to increase the maximum shear in the coiled tubing to equal the minimum yield in shear of the 

tubing. 

Newman, Corrigan, and Cheatham, in SPE 19229, indicate that coiled tubing can be pushed 

into a hole safely using compressive loads considerably in excess of the sinusoidal buckling threshold 

calculated by Equations 2-53 - 2-57. In the field cases they report, compressive forces greater than the 

sinusoidal critical force, F csin• have been used to push coiled tubing into inclined holes. Because of well 

geometry, they were unable to test compressive forces greater than the helical buckling critical force, 

Fchel. It is their belief that compressive forces larger than the critical helical buckling force, F chel• can safely 

be used to push coiled tubing into deviated holes, and they are proposing experimen1al verification of 1his 

assumption. 

Logging operations by Canadian Fracmaster and Esso Resources Canada in British 

Columbia have shown that coiled tubing can be safely subjected to buckling forces midway between the 

helical and spring limits. Recent experience of at least one of the service companies indicates that the 

critical load calculated from helical spring theory, F cspr• is a reasonable indicator of the near upper limit 

- of safe compressive forces to use to insert coiled tubing into deviated holes. This force is considerably 

larger than the force required to initiate helical buckling. It has been reported that when F cspr was 

"exceeded in moderation," no damage to the tubing was observed. 

These criteria (F csin• Fchel• and F cspr) should be used with caution and as guides rather than 

as absolute indicators. Judgment based on experience, though sometimes expensive to acquire, is of great 

value when dealing with such concepts as buckling and all its implications. Buckling does not necessarily 

imply failure, but indicates the onset of a condition which may precipitate failure. 

When more accurate or significant critical buckling load criteria are developed, they will 

be incorporated into CSTRESS either in addition to, or as replacements for the three criteria presently 

employed. 

2.8 HELICAL FRICTIONAL FORCE AND WCKUP 

Once coiled tubing becomes helically buckled, the tube body will exert extra normal force against 

the wellbore so helical buckling causes additional frictional force called "helical frictional force." The 

helical frictional force equation is evaluated in "Frictional Drag Analysis for Helical Buckled Pipes in 

Extended Reach and Horiwn1al Wells" (Jiang Wu and Haas C. Juvkam-Wold, 93-PEf-8). 

= r • (T )2 • A I • f (2-65)
Fhel-fric 

4 • E • I 
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where: 

Helical Frictional Force Fhel 

E = Elastic Modulus 


I = Moment of Initial 


T = Axial Compressional Force 


r Clearance 


f Friction Factor 


i. I = Segment Length 

Equation 2-65 is based on the following assumptions: 

1. 	 Axial compressional forces on both ends of the segment are equal which implies that segment 

length is relatively short. 

2. 	 Originally, this equation was derivated for weightless pipe in a straight wellbore. 

When axial compressional force is increased, the equation shows that helical frictional force is 

increased as the square of compressional force. This helical frictional force against the tube moving into 

the well causes extra axial compressional force for the next (upper) tube segment. If the helical frictional 

force is large enough, the compressional force is balanced by the helical frictional force no matter how 

much force is applied at the surface. In this situation, the helical buckling section locks and the tubing 

string below the helical buckling section cannot move down to the hole. 

2.9 TRIAXIAL, BIAXIAL, AND API STRESS ANALYSIS 

An element of material subjected to stress ux, uy, and az in three perpendicular directions is said 

to be in a state of triaxial stress. A coiled-tubing string subjected to axial load and pressure (external 

and/or internal) is in a state of triaxial stress (Figure 2-10). 

f~ 	 Fo Axial Lood 

Po 	 External 

Figure 2-10. Triaxial Stress State 

U

Pressure 
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2.9.1 	 Triaxial Equation 

The generally accepted relationship for the effect of axial stress on collapse or burst is 

based on the distortion energy theory. A closed triaxial design procedure has been developed using Von 

Mise's and Lame's equations. This present model does not consider torsional effects. 

Let E = Elastic Modulus 

D0 =Pipe OD 

D·I = Pipe ID 

ro = Pipe Outside Radius 

r·
I 

= Pipe Inside Radius 

= Yield Stress Us 

u. = Axial Stress 
p.

I 
= Internal Pressure (psi) 

Po = External Pressure (psi) 

The pipe thickness is 

(2-66) 

The cross area of pipe wall is 

(2-67)A= T •(D~ - Dn/4 

-
Axial stress contains axial force, bending stress, and helical frictional force. According 

to Lame's equation for a thick tube, the hoop stress uh and the radial stress ur exerted by internal and 

external pressures at the cylinder at radius equals r. 

(1 = 	 (2-68)
r 

and 

r~P- - r 2 P
1 1 0 0 (2-69)

2 2 
r 0 - r; 

For most cases, the maximum equivalent stress is at the pipe inside surface. Therefore, 

the equation can simplified by letting r = r; and rewriting the equation in pressure and diameter tenns 

so the above equations become 

(2-70) 

and -
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2 

p. - 0 p (2-71)2 d l
I 2 2 0


[ d0 - d·I 


d2 
let C (~ and Eq. 2-12 becomes 

2 • t • 
0 

- t) 

uh " (C - 1 ) Pi - C • P 0 

Von Mises's equation is 

(2-72)

(2-73) 


where u1, u2, and u3 are three principal stresses, and uy is the equivalent stress according to the three 

principal stresses. Because the stresses ur, uh, and ua are three principal stresses, they can be inserted 

into Von Mises's equation 

2 2 (2-74)2 u~ " [<ua - uh) + (uh - Ur) + (ur - ua>2] 

so the equivalent stress uv becomes 

Uv " ( 112 (ua - uh )2 + (uh - Ur )2 + (ur - Ua )2) (2-75) 

Combine Eqs. 2-70 and 2-71 with Eq. 2-74 and rearrange the terms in the equation. 

2 - u + 2CP· - P·1 ±J - 3 ua - 6 ua P·1 - 3Pf + 4u~ (2-76)p " a I 

0 2C 


or 

2±J- 3C2 ua - 6C2 uaPo - 3C 2 P~ + 4(C2 - C + l) Uy (2-77) 

2 (C 2 - C + I) 

In Eqs. 2-76 and 2-77, if uy is replaced with u8 (yield stress), the solutions P0 and Pi 

are the limited collapse and burst pressures. 

Mathematically, there are two solutions for P0 from Eq. 2-76 (for positive and negative 

square roots), but in practicality only positive real number(s) represent the collapse pressure P
0

• There 

can be one, two, or no solution(s) for the collapse pressure design. When bending stress is considered, 

caused by wellbore dogleg or helical buckling, the u
8 

in Eq. 2-76 is either: 

= Minimum Axial Stress (uamin) = Average Axial Stress - Bending Stress u8 

or 

u8 Maximum Axial Stress (uamin) = Average Axial Stress + Bending Stress 

This results in the solution(s) for collapse pressure design with minimum and maximum 

bending stress effects. 
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Note, when 118 is replaced by "amin and "amax• both "amin and "amax can have the 

positive square root solution. If this happens, the smaller value of the two positive square root solutions - is the upper boundary of e-0llapse design. In the same way, the larger value from the two negative 

square root solutions is the lower-pres.§Ufe boundary of the collapse design. 

Operating Pressure 
positive square root solutions 

negative square root 
solution 

min. operating pressure 

---~----+-----+-+<-+-.. Axial Stress 

.. .... "' 
·~ ·" "' ~~ c;; c;; c;; 
Iii Iii Iii 

·;; ·x·~ .. .. ..E 
Cl E 

:J .. :J 
E EQi·c: > ·~ .E .. 

E 

Figure 2-11. Bending Stress Effects on Burst Pres.§Ufe Design 

2.9.2 	 Biaxial Equation 

To disregard the internal pressure on e-0llapse pres.§Ufe design, let Pi = 0 and Eq. 2-76 

is simplified. 

~ 2 2 2±ua - 4 (aa - "v) (2-80) 

- 2C 

If 118 and uy are replaced by "amin (Eq. 2-78), Uamax (Eq. 2-79), and 118 (yield stress), 

Eq. 2-80 produces the e-0llapse design pressure for biaxial stress analysis. 

Let P0 = 0 in Eq. 2-77 and it bee-0mes 

(C - 2)118 ± J- 3C 2 a; + 4(C 2 
- C + 1) a~ (2-81) 

p. = ------'---=----------- ­
' 	 2 (C 2 - C + 1) 

The above equation is the burst design pres.§Ufe for biaxial stress analysis. 

where 

(2-82) 

2.9.3 	 API Equation 

API Bulletin, 5C3, 1989, "Formulas and Calculations For Casing, Tubing, Drill Pipe 

and Line Pipe Properties" (see for details) lists all API standard equations for axial stress limits, burst 

pressure limits, and four collapse pressure range limits. 
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Depending on the D/t ratio (diameter over thickness) of pipe, the collapse-tension curves 

for biaxial and API methods are different. Equations 2-68 and 2--09 are called Lame equations, they are 

derived from the thick tube stress (small D/t value). The API collapse pressure formula for the plastic 

zone is derived by slatistical regression analysis from more than 2400 casing collapse tests. The API 

collapse pressure formula for transition zone is determined by the curve fitting. This formula is used 

to determine minimum collapse pressure between its tangency to the elastic collapse pressure curve and 

its intersection with the plastic collapse pressure curve. The choice of triaxial, biaxial, or API criteria 

is left to the user. 
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3. Tortuosity 


- 3.1 MODEL DESCRIPTION 

When planning a well, the surveys generated from geometric considerations, i.e., kick-off point, 

build rate, path shape, etc., are smooth curves, whereas actual wells contain doglegs and other 

irregularities that increase torque and drag. When these "smooth curves" are input into the torque and 

drag model, the model predicts torque and drag values that are lower than those in actual wells 

containing doglegs and other irregularities. 

In the past, when "smooth" curves were used, the friction factors were artificially increased 

(e.g., from 0.22 to 0.29) to correspond to the increased torque due to hole irregularities. This technique 

gives good approximations of the actual torque, but it has the limitation that it predicts zero torque and 

zero frictional drag in vertical portions of the well, regardless of the friction fae10r, because the lateral loads 

are zero in these "smooth" vertical sections. The CSTRF.SS program calculates only the drag force. 

A very simple and elegant way to handle this problem been developed by Exxon, and was reported 

to us by Dr. Rap Dawson. 

To add tortuosity to the wellpath, a sinusoidal variation, whose period length (or cycle length) is 

""l, is added to both inclination and azimuth angle. This is in the form 

Tortuosity = T Sin (2TMD/ 1>.I) (3-1) 

where: 

T Amplitude or tortuosity number in degrees 

MD Measured depth (ft) 

1>.I Period length or cycle length for 2T 

In addition, the inclination angle is modified so that it will not become less than zero, since 

negative inclination angles are not allowed. 

The amplitude or tortuosity number T of the sinusoidal variation is varied according to the hole 

conditions. Exxon has found that a tortuosity of T = 1 represents typical field conditions. 

If the untortured survey data are of equal space and the value of measured depth for each survey 

station is n x ; 1 where n is any integer, then after calculation the survey data will not be tortured. 
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http:CSTRF.SS


. "fied . Eq 3 1 h MD n 'i.l th . dded . l" u· nd . th 
2

for each survey will be: 

This 1s ven m . - w ere = _ _, en tortuos1ty a to me ma on a az1mu 

Tortuosity T • sin (2T •MDIi. 1) 

. n•i.l 1
T • SID (2T • -- • ­

2 i.l 

T • sin (n • T) 


= 0 


Total dogleg added to the original survey depends on the survey data, Amplitude T, and period 

length. The amplitude or tortuosity number (T) is the maximum possible degree added to or subtracted 

from inclination and azimuth. 

It is recommended that L>I be chosen to do at least five times the interval between survey stations. 
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4. Program Installation 


4.1 BEFORE INST ALLING 

4.1.1 Check the Hardware and System Reauirements 

CSTRESSl is written in Visual Basic•. It runs in either standard or enhanced mode of 

Microsoft Windows 3.1 or higher. The basic requirements are: 

• Any IBM-compatible machine built on the 80386 processor or higher. 

• Hard disk. 

• Mouse. 

• CGA, EGA, VGA, Hercules, or compatible display. 

• MS-DOS version 3.1 or higher. 

• Windows version 3.1 in standard or enhanced mode. 

• An 80486 processor and VGA display is recommended. 

For assistance with the installation or use of CSTRESSl contact: 

Lee Chu or Gefei Liu 

Maurer Engineering Inc. 


2916 West T.C. Jester Boulevard 

Houston, Texas 77018-7098 U.S.A. 


Telephone: (713) 683-8227 Fax: (713) 683-6418 

Telex: 216556 


4.1.2 Check the Program Disk 

The program disk is a 31/z inch, 1.44 MB disk containing twenty files. These twenty files 

are as follows: 

SETUPKlT.DL MDICHILD.VBX 
VBRUNlOO.DL CMDIALOG. VBX 
VER.DL CSGDB.DB 
GSWDLL.DLL CTDB.DB 
GSW.EXE CDRAG4.EXE 
SETUP.EXE TEST.CDR 
SETUPl.EXE TEST.WDI 
SETUP.LST TEST.SDI 
GRAPH.VBX TEST.CT4 
GRID.VBX TEST.CP4 
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We recommend that all .VBX and .DLL files, that have the potential to be used by other 

DEA-67 Windows applications, be installed in your Microsoft Windows\SYSTEM subdirectory. This 

applies to all the . VBXs and .DLLs included here. The CSTRESS 1 executable (CSTRESS I.EXE) file 

should be placed in its own directory (default "C:\CSTRESSI "). All these procedures will be done by 

a simple setup command explained in Section 4.2. 

In order to run CSTRESSI, the user must install all the files into the appropriate directory 

on the hard disk. Please see Section 4.2 to setup CSTRESSI. 

It is recommended that the original diskette be kept as a backup, and that working diskettes 

be made from it. 

4.1.3 Backuo Disk 

It is advisable to make several backup copies of the program disk and place each in a 

different storage location. This will minimize the probability of all disks developing operational problems 

at the same time. 

The user can use the COPY or DISKCOPY command in DOS, or the COPY DISKETIE 

on the disk menu in the File Manager in Windows. 

4.2 INSTALLING CSTRESSI 

The following procedure will install CSTRESSI from the floppy drive onto working subdirectories 

of the hard disk (i.e., copy from B: (or A:) drive onto C: drive subdirectory CSTRESSI and 

WINDOWS\SYSTEM). 

1. Start Windows by typing "WIN" <ENTER> at the DOS prompt. 

2. Insert the program disk in drive B:\. 

3. In the File Manager ofWIIXlows, choose (RlDI] from the [File] menu. Type B:\setup anl ~ Fnler. 

4. Follow the on-screen instructions. 

This is all the user needs to setup CSTRESSl. After setup, there will be a new Program Manager 

Group (DEA APPLICATION GROUP) which contains the C.T. icon for CSTRESSI as shown in 

Figure 4-1. 
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Figure 4-1. DEA APPLICATION GROUP and "CSTRESSl" Icon 

4.3 STARTING CSTRESSl 

4.3.1 Start CSTRESSl from Grouo Window 

To run CSTRESSl from the GROUP Window, the user simply double-clicks the 

"CS TRESS l" icon, or when the icon is focused, press <ENTER>. 

4.3.2 Use Command-Line Option from Windows 

In the Program Manager, choose [Run] from the [File] menu. Then type 

C:\CSTRESSl\CSTRESSl.EXE <ENTER>. 

4.4 ALTERNATIVE SETUP 

If the SETUP procedure described before fails, follow these steps to install the program: 

1. Create a subdirectory on drive C: C:\CSTRESSl. 

2. Insert the source disk in drive B: (or A:). 

3. Type: CD\CSTRESSl <ENTER>. 

4. At prompt C:\CSTRESSl, type: 

Copy B:\CSTRESSl.EXE <ENTER>- Copy B:\*.DB <ENTER> 
Copy B:\TEST.* <ENTER>. 
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5. 	 Type: CD\ WINDOWS <ENTER>. 

6. 	 At prompt C:\WINDOWS >, type: 

Copy B:\VBRUNlOO.DL_ VBRUNlOO.DLL <ENTER>. 

7. 	 Type: CD\ WINDOWS\SYSTEM <ENTER> . 

8. 	 At prompt C:\WINDOWS\SYSTEM>, type: 

Copy B:\*.DLL <ENTER> 
Copy B:\*.VBX <ENTER>. 
Copy B:\GSW.EXE <ENTER> 

9. 	 Type: CD.. <ENTER> then key in "WIN" <ENTER> to start Windows 3.1 or later 
version. 

10. 	 Click menu "File" under "PROGRAM MANAGER," select item [New ...] click on [PRO­
GRAM GROUP] option, then [OK] button. 

11. 	 Key in ''DEA APPLICATION GROUP'' after label ''Description:,'' then key in ''DEAMEI'' 

after "Group File:," then click on [OK] button. A GROUP Window with the caption of 
"DEA APPLICATION GROUP" appears. 

12. 	 Click on menu [File] again, Select [NEW ...] click on "PROGRAM ITEM" option, then, 
[OK] button. 

13. 	 Key in "CSTRESSl" after label "Description," key in "C:\CSTRESSl\CSTRESSl.EXE" 
after label "COMMAND LINE," then click on [OK] button. The CSTRESSl icon appears. 

14. Double-click the icon to start the program. 
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5. Basic Operation of Microsoft Windows ·­
CSTRESS l runs in a Microsoft Windows environment. It is assumed that the user is familiar with 

Windows, and the user's computer is equipped with Windows 3.0 or later version. 

Some elements and terminology of Windows are reviewed here: 

r- Ml:umi:tt Bo.x 
,....- Control Box r- Tit!• Bar _ Ma.'Ximi:e Box 

-I 
file 

Output 
Window Graph .QpUon Jielp 
..tescade .• Shlft•f!i 

Ille Sh11HF4 
Arrange icons 

or 
Restore Box 

ALL 
fquivalent Stress 
ttydraullc Pressure 
~al Drag 
.Surface. Load 
13.ottom Hole Pressure 
(!ala Table 

Bl-Axial Graph 

Figure 5-1. Title Bar in Window 

S.1 THE TITLE BAR 

The title bar serves two functions: one is to display the name of the current window and the other 

is to indicate which window is active. The active window is the one whose title bar is in color. (On 

monochrome monitors, the difference is shown by the intensity of the title bar). The user can make a 

window active by clicking anywhere within its border. 

S.2 THE CONTROL BOXES 

At the left side of the title bar is the control box. It has two functions. First, it can display the 

CONTROL menu, which enables the user to control the window size using the keyboard. Second, 

double-clicking the control box will end the current program. 

During execution of CSTRESSl, the control boxes are not needed. The program will run 

according to its own flow chart. 

S.3 MINIMIZE AND MAXIMIZE BOXES 

At the right side of the title bar are the MINIMIZE and MAXIMIZE boxes. The box with the up arrow 

is the MAXIMIZE box. The box with the down arrow is the MINIMIZE box. If a window has already been 

.-- maximized, the MAXIMIZE box changes to a RESTORE box with both up and down arrows, as shown in 

Figure 5-1. 
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• 	 Clicking on the MINIMIZE box will reduce the window to the size of an icon. The window's 
name in the title bar appears below the icon. To restore a window from an icon, double-click 
on the icon. 

• 	Clicking on the MAXIMIZE box will make the window take up the total working area. 

• 	 Clicking on the RESTORE box will make the window take up a portion of the total working area, 
which is determined by how the user manually sizes the window. 

5.4 TEXT BOXES 

TEXT boxes can display the information that the user enters. Sometimes there will be text already 

typed in for the user. The user can utilize arrow keys to edit the existing text. Figure 5-2 shows a 

typical text box. 

Company Name: _Maurer Engineering Inc. ·­
Project Name: DEA 67 
Well Name : Slimhole 
Well Reid: Coiled Tubing 
Well City I Sfate : Houston Texas 
Date: 11993Apr 
Comments: E11ample 

Figure 5-2. Text Box 

5.5 CHECK BOXES 

A CHECK box indicates whether a particular condition is on or off. When it is on, an X appears. 

When it is off, the box is empty. Figure 5-3 shows a typical check box. 

- Calculation 0 ption: 

IZI Include A&M buckling criteria 

IZI Include helical frictional force 

IZI Include bending stresses 

Figure 5-3. Check Box 
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Figure 5-5. Command Buttons 
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,_., 5.6 OPTION BUTTONS 

OmoN buttons are exclusive settings. Selecting an option immediately causes all other buttons 

in the group to be cleared. Figure 5-4 is a typical option box. 

!Azimuth: 

@Angular 

0 Oil Field 

Figure 5-4. Option Buttons 

5.7 COMMAND BUTTONS 

A COMMAND button performs a task when the user chooses it, either by clicking the button or 

pressing a key. The most common command buttons are the OK and Cancel buttons found on almost 

every dialog box. In most cases, there is a button with a thick border-the default button which will be 

executed if you press <ENTER>. Figure 5-5 shows a typical command button: 

5.8 LIST BOXES 

A UST box gives the user a list of options or items from which to choose. If the UST box is too 

small to show all possible selections, a SCROLL box will appear on the right side of the box. The user 

makes a selection from a UST box by clicking on it, or from the keyboard, highlighting the desired item 

with the arrow keys, and then pressing <ENTER>. Figure 5-6 is a typical list box. 

Light Yellow 
Define Color ·~· -

Light Green 
Light Cyan 
Light Red 
Light !-4agent 

Figure 5-6. List Box 
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5.9 DROP-DOWN LIST BOXES 

A DROP-DOWN LIST box is indicated by a small arrow in a box to the right of 1he option. The 

current setting is shown to the left of the arrow. When 1he user clicks on the small arrow, it drops to 

list all selections. A typical drop-down list box is shown in Figure 5-7. 

Nozzles:~

! Nozzle Sizes. ·.· ... ·... ·. ·f···..•Nozzle Si2et 
TFA 

Figure 5-7. Drop-Down List Box 

5.10 SCROLL BARS 

SCROLL BARS are graphical tools for quickly navigating through a long line of items. There are 

two types of scroll bars: HORIZONTAL and VERTICAL SCROLL BARS. 

The small box inside the bar is called the SCROLL BOX. The two arrows on the ends of the scroll 

bar are scroll buttons (Figure 5-8). Clicking the scroll buttons or moving the SCROLL BOX will change 

the portion of the information you are viewing. 

I t~I 
Figure 5-8. Scroll Bar 

5.11 GRID 

GRID displays a series of rows and columns (Figure 5-9). In case of a long list of items or a large 

amount of information, scroll bars will attach to the grid providing easy navigation. 

O.D. 11.D. l'Wt in air IDensit.P I Elastic I Yield +-
(in) llin) Ilib/ft) lllb/ft3J l[psi) l[psi) 

32 2.000 1.688 3.on 490.0 30000000 70000 
33 2.000 1.624 3.638 490.0 30000000 70000 
34 2.000 1.594 3.896 490.0 30000000 70000 
35 2.380 2.157 2.638 490.0 30000000 70000 
36 2.380 2.125 3.004 490.0 30000000 70000 
37 2.380 2.107 3.207 490.0 30000000 70000 
38 2.380 2.063 3.697 490.0 30000000 70000 .__ 
39 2.380 1.999 4.391 490.0 30000000 70000 .__ 
40 2.380 1.969 4.709 490.0 30000000 70000 -41 2.880 2.625 3.671 490.0 30000000 70000 + 

Figure 5-9. Grid 
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 In the INPUT Window, grids are used to let the user input data. Some columns of grid only allow 

number input. Typing of an alphabetical character is prohibited by the program. The user can edit an 

entry by typing desired characters or pressing the <BACKSPACE> key to delete. In many grids, just 

like a spreadsheet, the user can insert and delete a row. 

On the other side, grids are for presentation only in the OUTPUT Window. They do not allow 

editing. 

The grid supports word-wrapped text presentation, resiuable columns and rows, etc. Even though 

the user can manually change the cell's column width or row height, we do not recommend this because 

all grids in CSTRESSl are carefully designed to fit the length of the appropriate data string. 
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- 6. Running CSTRESSl 

CSTRESSl runs in Microsoft Windows environment. Windows' graphical user interface (GUI) 

and point-and-click environment gives the user the flexibility that is needed for today's software. 

6.1 OVERVIEW 

There are two major windows in CSTRESSl: 

1. INPUT-CRITERIA Window 

2. OUTPUT Window 

Only one window can be shown on the screen at a time. The menu bar, control button, arrow 

keys, hot keys, etc., can be used to control the program's flow and the keyboard or mouse to input the 

data. F.ach major window contains several sub-pages or sub-windows to hold different groups of input 

and output information. 

The menu bar selection is not always available in certain sub-pages or sub-windows. This type 

of design is to reduce the possibility of destroying the program in operation flow. 

TABLE 6-1. Input Criteria Window Menu 

II FILE MODEL PAGE RUN CUSTOMER UTILITY HELP II 
New Project Pick up (Logging) Next - F11 Start Foreground Color Assistance 
Open Project Slack off {Logging) Previous - Fl 2 Background Color About 
Save Project Pick up (Drilling - Tripping) First Monochrome 
Save Project As... Slack off (Drilling - Tripping! Last English 
New File Drill Metric 
Open File Consider Hydraulic While Tripping Well bore 
Save File 
Save File As ... 
Print•, 

Current Page 

All Pages 


Exit 


-

TABLE 6-2. Output Window Menu 

FILE WINDOW GRAPH OPTION HELP 

Print Report/Graph Only Cascade - Shift F5 Curve Option Assistance 
Print Project File Tile - Shift F4 Image File Format •, About 

Bitmap 
Metafile 

Print WCI and SDI File Average Icons 
Print TOI and POI File All 
Copy Graph to Clipboard Equivalent Stress 
Save Report Disk File Hydraulic Pressure 
Back to Input Axial Drag 
Exit Surface Load 

Bottom-Hole Pressure 
Data Table 
Bi-Axial Graph 

6-1 



-----

.. 1, I·• ._'DEA AFPt.JCATION GROUP 

II • II 1= 
CSbeu1 1~ T~1 Reomod4 

D l.~I 
CEMENT H'l1>MOO 2-1 

[ffiJ• 
Main Pi ~ l~ol a 

BUCKLE1 rq.-1e..so... 
VSIUOI oasic:rn• 

Micmsdl Toca 10StmtUo 

m• [ffiJ•,,....,......Games 

-
=L-1 lntroduction 1~ 
..!!!.. ~ 

Cailad Iubing SDI& Aoablii& MDdEll (CSIUlll ~ Dl 
C.T. Stress/ Drng I Buckling I Hydrnulics Model 

DEA-67 

Ptojod lo D'""'op and Evaluate Slioo-Hole and 


Cailed-TulMng T echnologp 

By 

Maw•• Engfttering Inc. 

. 

TIU .,_igliled 19S3 conli-el r-and - - ­

I 
•• lor the a'8 use ol P.ticip.U Gift llhe DrAng Engilwering 
Aa:ucielion DEA-67 proied1 .,.. ttm llffiietec. and .., not to 
be cildoaed to att.. pmtiea. Dete output Ira. lhe PIOCI'- can 
be disdo•ed lo the UWd ..,W.. Perticiponl• <nd their ""iiole• 
•• lree lo .-. copi9s of a.a report and imoura• for ttm in-


I hounuaeanly. 


M-..m EnP-ering Inc....... no _,..., 01 •••aenlalion.

I eilher e11q11e•sed Of illplied. with respect to the progr- or docu­
....tlll.ion.. induding lheir quelil,. pedm-.ce. -cheMbilitJ. 


Ace 
 or fineaa lor e particular putpose. 

E I J;onl- E.m II I 
G 

VtiuaiBai:ic Ac<ot• 

6.2 GEITING STARTED 


Bring up Wumws anl select "DEA APPllCATION GROUP" ~Ire active winklw, ~ s00wn in Figure 6-1. 


­

Figure 6-1. "DEA APPLICATION GROUP" and CSTRESSl Icon 

This window may contain more than one icon. Double-click on the CSTRESSl icon, the 

INTRODUCTION window with two command buttons, "Exit" and "Continue" will be displayed on the screen. 

­

Figure 6-2. Introduction Window 
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- Clicking "Exit" will terminate the program. The "Continue" button is the default command which means 

that the user can press the button by pressing <ENTER> or clicking the mouse. This will invoke and display 

the INPUT Window. Note that after the INTRODUCTORY Window appears, it takes a few seconds for the 

command buttons to be responsive; it is loading necessary files. 

6.3 PULL-DOWN MENUS IN THE INPIIT WINDOW 

The CSTRESSl menu system provides many tools that the user will utilize while running the application. 

As in other Windows applications, the user can pull-down a menu by clicking the menu name with the mouse, 

or by pressing the Alt key on the keyboard and then striking the first letter or the underscored letter of the menu 

name. Once a menu is displayed, the user selects a command by clicking the command name with the mouse 

or by highlighting the command name and pressing <ENTER> . 

There are six menus in the INPUT Window: File menu, Model menu, Page menu, Run menu, Customer 

Utility menu, and the Help menu as shown in Figure 6-3. 

'- Figure 6-3. Input Window 

The page number is shown on the right-hand side below the menu bar. These five pages are illustrated 

in detail in the next section. The Page, Run and Help menus are enabled for five pages. Model and Customer 

Utility menus are enabled only on the first page. However, the last item "Wellbore" under Customer Utility 

can be selected only on the fifth window page. 

For the File menu, the four commands on project file ("New Project," "Open Project. .. ," etc.) are 

enabled only on the first page while the four commands on file ("New File," "Open File... " etc.) are enabled 

only on pages 2 through 5 of the INPUT Window. 
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Hew Project P-1ol5 
Jlpen Pro)eCL.. 
Saye Project 
s~ Project A.a•.• 
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Open File ... 

~·""' Flle 
Save Flle As••. 

f'rlnt •• • 
Elllt 

The File menu contains commands for creating, retrieving, saving and printing input data as displayed in 

Figure 6-4. 

-I 	 Input - [Criteria Window! 
Elle Model E'age Bun Customer J.!tlltty Help 

Hew Project P-1ol5 

Jlpen Pro)eCL.• 
Saye Project 
Savi: Project As ••• 

N"'ll File 
Open File ... 
~ave Flle 
Save Flle ,4s... 

f'rlnL .. · I Curren~~ge·.:1 

E111t I All Pageo 

Figure 6-4. File Menu 

When the user starts CSTRESSl, it automatically opens a new project (by default: Projectl.CDR) and a 

set of input data files, namely, Projectl.WDI, Projectl.SDI, Projectl.CT4 Projectl.CP4, all in the current 

subdirectory. The reason for using the project file is for quick, future retrieval of a set of input data_ The user 

can open an existing project file without opening each individual (.WDI, .SDI, CT4, _CP4) file. The project 

file, which is a collection of the paths and file names of all input data files, will do the rest of the retrieving 

work for the user. 

However, although the listing in the CRITERIA Window (Page 1) represents files, CSTRESSl does not 

automatically create files on the disk when the user starts CSTRESSl. The same is true with "New Project." 

Only when the user chooses one of the Save commands from the File menu does CSTRESSl actually save 

something to disk. 

1. 	 "New Project" command clears every input data file and displays a set of null input data files with 

default names in the CRITERIA Window. 

2. 	 "Open Project. .. " command opens a dialog box which enables the user to explore the file system for 

input files with extension name ".CDR." 
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- 3. "Save Project" command replaces the previous version of each of the input data file in the project with 

the modified one. Note that the project file (.CDR) does not contain any input data. It is simply a list 

of all the input data files in the project. That list is updated every time the user saves the project. 

4. 	 "Save Project As... " command opens a dialog box. The user can specify the drive, directory, and the 

name of the project tile. 

5. 	 "New File" command clears every entry box associated with the current page, (i.e., one of WDI, SDI, 

CT4, CP4 files). 

6. 	 "Open File ... " command opens a dialog box which enables the user to explore the file system for input files 

with exten&on name which is determined by the current page the user is in. For example, in page 2, the 

user clicks the Open File ... ; the pattern for the file list box in the dialog box will be •'. WDI. '' 

7. 	 "Save File" command replaces the previous version of the input data file. 

8. 	 "Save File As... " command enables the user to save a file under a new name the user specifies while also 

retaining the original file. The new file will be associated with the project file when the user saves the 

project. 

9. 	 "Print" command allows the user to print the input data of the current page or all pages. 

10. "Exit" command terminates the current application. CSTRESSl will prompt the user to save the - files, if they are not saved. 

The files that make up a project do not have to be in one directory on the hard drive, since the project 

records the detailed path information on each input tile. A single file such as an SDI tile can be part of more 

than one project. However, if the user renames or deletes a file outside of the CSTRESS 1 application and then 

runs CSTRESSl and tries to open the file, CSTRE.5Sl displays an error message to warn the user that a file is ~. 

The Model menu contains commands for five different coiled-tubing operations as displayed in Figure 6-5. 

· · Pick up (Logging! 
./Stock off (logglngJ 

Pick up (Orilllng-Trlpplng) 
Stock off (Orillin11Trippin9J 

I Drill 

I .J Consider hydraulics wt.lie tripping 

Page 1ol5 

Figure 6-5. 

1. "Pick Up (Logging)" operation allows pick up of the coiled-tubing string with the logging tool 

connected at the end. 

2. "Slack Off (Logging)" operation allows the coiled-tubing string to be run into the well with the 

logging tool. 

-
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f)rs1 
LastI 

Figure 6-6. Page Menu 

3. 	 "Pick Up (Drilling-Tripping)" operation allows pulling the coiled-tubing string together with the 

bottom-hole assembly out of the well. 

4. 	 "Slack Off (Drilling-Tripping)" operation allows slack off of the coiled-tubing string with BHA. 

5. 	 "Drill" operation simulates the drilling operation. 

6. 	 "Consider Hydraulics While Tripping" tells the program to calculate only the hydrostatic pressure or 

to calculate surge and swab pressures (pick-up, slack-off operations) and circulating pressure (drilling 

operations). The check mark has to be at the front of this command or it will only calculate hydrostatic 

pressure. 

The Page menu contains commands for browsing and navigating through the five pages as displayed in 

Figure 6-6. 

1. 	 "Next" command leaves the current page and goes to the next page. Before doing so, the program 

will first check the validation of the input data in the current page and asks if the user wants to correct 

the invalid data entry. Then it will prompt the user to save the current file if it has not been saved. 

2. 	 "Previous" command functions the same as "Next" command, but in the opposite direction. 

3. 	 "First Page" command leaves the current page and goes to the CRITERIA Window. It will check the 

input data and prompts the user to save the file if the file on the current page is not saved. 

4. 	 "Last Page" command leaves the current page and goes to the PARAMETER DATA INPUT Window. 

It will check 1he input data aIXi prompts 1he user t> save 1he file if 1he file on 1he current page is mt saved. 

Usually, if all data are matched and consistent, the user will have no problem leaving one page for 

another. However, in some cases, the program will prompt a warning message even though each individual data 

page is good. One possibility is that an existing file is opened on the first page (Criteria page), and the user 

moves to the last page without going through the preceding pages. The program has no knowledge of the 

validation of 1he data in preceding files. In 1his case, going through 1he preceding plges will help clear 1he confu.9on. 

The Run menu contains the command that the user chooses when ready to start calculation. The "Start" 

command does just that. The user can start the calculation from any page. The program will check the 

validation of all data. 
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Figure ·6~8 shows this menu. 

-I Input · !Criteria Wlndowj 
flle Model f-ge Bun Customer \ltllity Help 

Asslatance ... 
About. •. 

Figure 6-8. Help Menu 

-I 	 Input· (Parameter Oat• Input Window! 1-1; 
file Model E;ge Bun Customer !!tJllty ·. . •. Help 

Foreground Color 
Background Color 
~nnochrom'~ 

-'English 
Mt: tile 

Wellbore.••- ­

P-5ol5 

Figure 6-7. Customer Utility Menu 

-

-
- The Customer Utility menu contains the command that enables the user to select the color, unit, and 

wellbore schematic. 

Figure 6-7 shows this menu. 

1. 	 "Background Color" command opens the "Color" dialog box, which will let the user select the 

desired background color. 

2. 	 "Foreground Color" command opens the "Color" dialog box, which will let the user select the 

desired foreground color. 

3. 	 "Monochrome" command allows the CSTRESSl program to run with a monochrome monitor. 


4. 	 "English" and "metric" menu allows the user to select the desired unit. 


5. "Wellbore" command shows the wellbore schematic. 


The Help menu gives the user information about the assistance and computer systems. 


1. 	 "Assistance... " command opens the "Assistance" dialog box, which displays MEi's address, phone 

number, and other applicable information. 

2. 	 "About... " command opens the "About" dialog box, which gives the user instant reference 

information about CSTRESSl and current computer system information . 

-
. 
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6.4 THE INPUT WINDOW 

In the INPUT Window, there are five pages according to different input data files. These five pages are: 

1. CRITERIA Window 

2. WELL DATA INPUT Window (WDI) 

3. SURVEY DATA INPUT Window (SDI) 

4. TUBULAR DATA INPUT Window (TDI) 

5. PARAMETER DATA INPUT Window (PDI) 

When the user leaves each page, except the first page, the program automatically checks for input errors 

on that page. 

6.4.1 	 Page 1; Criteria Window 

Figure 6-9 shows a typical CRITERIA Window. The paths and names of input data, their saved 

status (Saved or Not), CT operating model, hydraulics consideration, and the unit system currently in use is 

displayed on this page. 

Coiled Tubing Stress Analysis Model (CStress) 

Project file: C:\VB\CH\TEST.CST (>) 

Well Dme. Input file: C:\VB\CH\TEST.WDI (>) 

SuNBy Data Input file: C:\VB\CH\TEST.SDI (•) 

Tubular Data Input file: C:\VB\CH\TEST.CT4 (•) 

Parameter Data Input file: C:\VB\CH\TEST.CP4 (•) 

Model Selection: Slack all (Logging) (Consider Hydraulics) 

Unit Syotem Used: Engli&h 

Note: (•) • Savad. (-) • Not savad 

Figure 6-9. Criteria Window 
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~1 Input· IW•ll Date Input Window! 

fll• Mod•I flu• Bun Cuatam•r Utlllly tl•IP 


C·\VB\Ql\JESI 'WDI 

Company Name : !'A aurer Engineeril'.!9Jnc,______ 
Project Name : DEA67 
Well Name: Slimhole 
Well Field: Coiled Tubing 
Well City I State : Houston Texas 
Dale: 1993Apr 
Comments: Example

-I 
Ell• Model 

Uni tm:unlilo 

,...Depth:­

@Feel 

0Mol• 

·1nc-ion:l 
@o..-.. 

Oooa. Min 1 

0 OiFmld 


Input - !Survey Dote Input Window! 

flu• Bun Cuatom•r Utlllly 
C·\YB\CH\TEST SDI 

~ l!unud IDGinl!iln ~ 
Rmtlb ~ oWlt. 

1 0.0 0.00 

2 
0.00 

1111.0 0.00 0.00 
3 400.0 0.00 0.00 

800.0 0.00 0.00' 5 1200.0 0.00 0.00 
6 1600.0 0.00 0.00 
7 0.00 
8 

2000.0 0.00 

2400.0 0.00 0.00 

9 2800.0 0.00 

10 
0.00 

3200.0 10.00 0.00 

[E*
I 

(nserl Line D.-•Line 

Tortuo1ilJ_ .. 

tl•lp 

• 

.. 


6.4.2 	 Page 2; Well Data Input <WDD 

Figure 6-10 shows a typical WELL DATA INPUT Window. -

Figure 6-10. Well Data Input Window 

The user is asked to input a series of strings representing the company name, project names, well 

location, data, and comments. They are optional and need not be completed. They will not be used in 

calculation or in the file name specification. 

The strings must be less than 30 characters in length. 

-

6.4.3 	 Page 3; Survey Data Inout <SDD 


Figure 6-11 shows a typical SURVEY DATA INPUT Window. 


~ 
Figure 6-11. Survey Data Input Window 
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logging I ool lnl...mM>no 

Ilogging I ool lenglh(ft) I 50.0 I INozzle Sizet I! I 
~ Logging I ool llloighl(lbll . 300 .. 

~fe::'.o11::-~1:"'.oo1~0:'.'.....::':=====~,~~N::'...i~~-~C~J'."::=====::::::::...... 	 No. (l2ndl 
. 	 !~11-..t~woiphll-· ~eea~I~1~----11 + :~
IDrag(lbll I 300 I 	
=~~--~-~~~ - __..!.__ 12. 


11..t Outsido CT: 4 12. 

~-----------' ~111=..i"'-~·"'"°""''eea,,,.,_1_,_I--'1=0=.1111=--.__JI -S 12. 
.-Weight Ol'I Bil·------~ "'"H)'Clraulica Model: TFA [n2) 

0 P-i.- @B-- ----~ 
IW•iah! ... Bilflbl) I 5000 I 	 I I 
=~~~~~-~~~ I~ i:~001•21 I ~7o: I I 0-AI I

The user can input up to 400 survey data points. The measured depth, inclination angle and 

azimuth angle each have two unit options, independent of the application unit system the user selected for the 

application. 

When the cursor is in the text box, press the +- or ... key to move the cursor inside the box to edit. 

Pressing the t or i key will move the cursor to the above or the lower box. If the user wants to move the 

cursor to the right or left box, hold down the Ctrl key and press ... or +-. Of course, the user can use the mouse 

or press the tab key to locate the cursor. 

The SDI files used in CSTRESSl are compatible with any SDI files in other DEA software 

applications developed by MEI. 

The tortuosity command button lets the user torture the smooth survey data, so that the doglegs add 

to the original survey. See Section 6.8 for details. 

6.4.4 	 Page 4: Tubular Data Input ITDD 


Figure 6-12 shows a TUBULAR DATA INPUT Window. 


=I Input· [Tubular 0"'8 Input Window] 
Elle Model Eage Bun Customer l.lUllty Help 

C·W!!\CH\JESI CT4 

SDI IND lltl 111100 0 lllol 11.D. IHI I 8000 I 
Tuhular Del• n • .,. boUontl:::;::;:::::;:::;;:::;:=;::;:=;~::::::;;=:;::;::;:;::::::;:::;:::::;::::

No. DensilJ I 0.0. I 1.0. I W. M I L__.. I E I Yleld I Acc.. L 
8 llblft31 I lint I rnl I llbJlll I lftl I lasil I ,.,.;, I IHI 
1 490.0 1.500 1.250 1.836 4000.0 30.0E.o& 70000 4000 

;:::::;;::==::::::;i

~ 490.0 1.500 1.232 1.955 3950.0 30.0E.o& 1111000 7950 

°""' 
Dal:a Base ... 

1-N<>nlo." 


­

Figure 6-12. Tubular Data Input Window 

The spreadsheet-like Tubular Data table is similar to the SDI file input, but TDI uses grids instead 

of text boxes which are used in SDI. 
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.­ Depending on which model has been selected, the user can input only a fraction of the data 

window. The TDI Window groups the same type of input data and places them into frames. For example, if 

the user selects the slack off (logging) model, the nozzle and weight-on-bit information is not needed on the 

screen. The tide color of 1he llOll-eS\lential frame groop becomes gray shading. The user canmt ac.ces; 1hese datl. 

BHA and CT string data are input into the Tubular Data table. The Tubular Data table input starts 

from bottom tool (BHA) to the surface. While the user edits the section length, the program continues to track 

the accumulative length of the CT string and BHA, then displays the accumulative length (i.e., Well MD) in the 

upper center of the screen. When the user selects the logging model, the logging tool length with the CT string 

length and/or BHA length becomes the Well MD. 

At the top right-hand comer of the TDI Window, the program displays the SDI TMD which is the 

total survey measured depth input in the previous SDI Window. The Well MD must be smaller than or equal 

to the SDI TMD. 

Sometimes when the user switches from one unit system to another, the previously compatible data 

may become unmatched due to the rounding off of the data during the conversion operation. Mostly this happens 

on measured depth in the SDI file and bit depth in the IDI file. Remember that the unit for measured depth in 

the SDI file may be different from the one in the application unit system. 

If the user clicks the Database command button, the program opens the disk database file. The 

- default file name is CDDB.DB. 

-I Input- [Tubuler Debi Input Window] 
file Madel 01ge Bun Cuatomer Utility Help 

C·\VB\Dl\JEST CJ4 

SDI TMD (Ill 00111.0 "'• .. D 1111 I ..OU I.. 
... r...o... n.... bottGml: 

No. D-1 D.D. I l.D. I W.• 1L-1 E I Y-oold Acc. L I II I,_,• 111/1131 I r.,1 I r.,1 I llb/111 I IHI I•-• I lnlil IHI I 
1 490.0 z­ 490.0 -I CT DotaBne Open .. 

-
Fi•K-: D.irectDl'ies: I Oil: I f 

lr:tdb.db I c:\vbldl -I I"""-db IO c:\ 
c..n..1 l.fL. ...... 

(Ovb - -Logging Tool lnl°" -
llo...-...Toal L­ ~ch 

O:!l11---.... ToalW..i.n 

~eon.. Tool Draa: - :c-
Dr--fl Li" n .. o1 .Uoe: D1~1: 

I 
lcr DB~- ICTDB.DBI [!] 1Elc:leechu66 ltl 

~weJ,gl\~ an l•it iH,.troulic:o Modolo TFA 1"'21 

lllfeigh! on Bil!..J I I 
OPowmLM1 ®B--lic I I5IDI 

lpy'""' I 
12-0 

I:yp 1!!!1100112) 5.00 
I 
I Cle•AI I 

llOOIJI :>elllcater. ::>..:.. oft llogg1n1J -\AllSI ... 

Figure 6-13. Open CT Database File 
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Click the OK button, the coiled-tubing database shows on the screen. The user can edit the data 

and save the changed data on the disk file. After finding the data, click the OK button, this will copy the data 

to the TDI table. 

Input - [Tubular Debi Input Window] 
flle Model eaue Bun Customer l.!Ullty Help 

C·\118\Dl\JESJ CU 

Wei 11.D. (HJ 8000 

Data Base 

1.688 JOOIDDI 1llOOO 
1.624 JOOIDDI 1llOOO 
1.594 JOOIDDI 1llOOO 
2.157 JOOIDDI 1llOOO 
2.125 JOOIDDI 1llOOO 
2.107 JOOIDDI 1llOOO 
2.1163 300IDDI 1llOOO 
1.999 - 1llOOO 
1.969 300IDDI 1llOOO 
2.625 JOOIDDI 1llOOO • 

DI: c:...c.i 1......1R.... DeleleRo. 

Figure 6-14. Coiled-Tubing Database 


The PDI Window also provides the casing database (Figure 6-15). 


-I Input - !Parameter Dato Input Window] 
file Model eaue Bun Customer ].!tlllty Help 

C·\YR\CH\TEST tp4 

DK 

Data Base 

Casing Data Base 

60.000 

0.545 
0.297 
0.350 
0.400 
0.450 
0.495 
0.333 
0.315 
0.435 
0.489 

11.1184 
11.000 
10.8811 
10.112 

ln•ed Row Dlllete Row 

• 


1 lorce 

... 
FkW4f H~-----rr-r:Cald.OOn:-:-.,...,.,.---,0.-:-erv-.-=.....,.-=:-:---r,..,.-------~ 

I (up!!) 10.00 I 11.D. of inleresl 

llodel Selected: Slack off !Logging) -C....- H,dreulics 

Figure 6-15. Casing Database 
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-I 	 Input- (Parameter Diii• Input Window] 
fll• Madel fag• Bun Cualomer IJdllty Help 

\v'ol 11.D. (HI 11110.0 ........._.. (Ir ­ ...d-~ 

• I lftl I r..1 I I,_, I ,,..;, 

,__.!_ 	

Al Well 11.D.: P•o P.(psij 13000 IFr.:. P.(psl] 

In-

D-

l:loor 

Det:aa...... 

15000181 s- .....n.oc1... - ­
No. Oe-n-ion I F- I l.D. I Frie. I ..... p I Fi-=- p 

7.000 	 0.21111 20111.-­2 -hole 5000.D 6.1110 D.300 1500 3500r 
1 

rl:ablo Weigh!: l[-...s""occ"'-o: 1-c:..w;.., Option: 
500!flbJllJ 	 I 0.3H I l!e!!I I II 

181 lncludo Al.II buckling aileri.o.-Swf-=eE~Drag: 

ISl<Ming Bo.01og 1(111) I 71111IT.-.0 llO¥ing Sp-~ 
R... B-*Toneion ll>ll 300 1811-- lriclianol lorceIIPtim! 	 I 1111.0D} 

.... Calculltian Abibuta: 
 181 lncludo bending ..._
• ITube de.... incre. llftl I 5111.0[!'low Aate: 

IC<rlcMtian o.... 11111 I 1111.0
I 111!!!1 I 1I 111.D. al inlo'"'I IPtl I 7950.0 I10.111 

...... Soloctod: Slor:t alt (Leaaing) -C...- Hydr.. ­

The default database file is CSGDB.DB 

6.4.S 	 page S; Parameter Data Input <PDD 

Figure 6-16 shows a typical PARAMETER DATA INPUT Window. 

.­

Figure 6-16. Parameter Data Input Window 

In POI the user finds the same input styles as in TOI, the data are grouped by frames. Some of 

these frames can only be accessed with certain operating model selection. 

Well interval input sections are from surface down. When the check box is left empty in the 

"show pore/fracture pressure," the program does not consider pore/fracture pressures. 

In the calculation option frame, there are three options that will affect the results of the calculations. 

The formulas for these calculations are discussed in Chapter 2 "Theory and Equations." 

- .­
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Pull-down the Customer Utility menu, select the wellbore option and the wellbore schematic will 

be displayed on the screen (Figure 6-17). 

flle 
llD lftl I 

"Wei 11.D. (ft) 

llDI. 

2000. 

]000. 

4000. 

51Dl. ~ 

6000. 

7000. 

7950. 

Wellbore Schematic 

' 

I 

I 

I 

. ' . ' ' ' ..
I> I I I+' I 
I' I I I 0 ' ' 
I I I I I 0 I' 

: : : : : : : : 
-t-+-i-i­ -~--~-~-~-
'I' t 'I I I 

l ~ j 1 ; ~ ; ; 
t • o I 0 I I I........... ____...... . ' ' ' ... . 
I I I I 0 I I I 
'I' I 0 I I I 
I''' 0 I I I 
I I' I t I It 
I Io o o I I I 
I I I I 0 I I I

'.'' . ''' r•T • .,.,. ••,.-v 'f""r'" 
I l I 0 I I' 

' >I ' ' I I.. ' . ' ..
I I I I It 0 I 
I I I o' 0 I. . ' .. '. 
I I I 0 'I I-:-: ~-:- -·:·:-:-:­
.' ' .... 
: : . : : : : : 
'I I I I I 0 
I Io I I I I' '. ' ' ........... ___ ....... 
0 I I I I I I 

' ' ' ' ' . ' 
' I I I I I 0 
I I I I I I I. ''' . ' 
I I I I I I . ''' . ' . . '. . '·r-,.,.,. · ·r·r· 
'' I I I ' ' 
I I I' 0 0 I 
I It I I I I

' ' ' ' . ''I I I > O I I 
I I I 0 0 '0 
'I I> 0 '< 

-~-~-~-~- --} :--:-­
' ... ' '' I I 0 0 I I I'' . . . . ..... ' .. 
I I I I I <I.. '. ' . ' 

Welllore 

Quil 

llodelSeled;;d._.:::==============================::'....::======:J 

Ip 

Figure 6-17. Wellbore Schematic 


The wellbore graph is only available on the POI screen page. 


6.5 SAVE INDMDUAL FILES 

The user can save WDI, SDI, TOI, and POI files individually. While the POI page is on the screen pull­

down the File menu, the user can open/save the POI file to a diskette. It is the same as managing other input 

pages. 
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Sa~ Proj1~cl As... Al Well 11.D.: Pole P.(paij 13000 IF•-=- P.1....1 151111 I 
New Ale 

I r... I l.D. I Frie. I PoreP I frac. P 
Open Ale ••. I lftl I ro.i I I'"'"'' I lnait 
SBYeAle 7.000 0.2111 2000 
SBYe AleAa... 51111.0 6.000 0.300 1500 3500 

frlnL.. Current Paqe I 
All PagesIE!dl 

I 

In-

D-o 


Clo• 


Data&...... 

,~Weight:~1-surt.,.Pr....,10: 
!illllI _111!!!1 I I 

-surface E....._.. Dr-s 

ISlulfing a.. Dr•1 II!!!! I 700 

IReolBal- 11>11 300 

lc~..,o-: 
_l~•I I o.:m 

1811-A&M '-king crilorio 

[rubino Mo•iflo Sp...t.~ 
1811-... heicol lriclianol lorcellltlhnl I 100.00 I 

!Alculolian ITube - incnt. ..... I 500.0 1811-... bm*1g · ­lflowllolc ,.., IIC.ae&.tion inl.-v. 100.0 
10.00 IM.D. af inte1eat l(ltl I 7950.0 I_I 1111!!!!1 I 1 I 

11..iol Soloded: Drill 

Figure 6-18. Manipulating with POI File 

-


-
-I Input- [Parameter Doto Input Window] 

E!age Bun Cuatomer \lllllty Helpflle Model 
Mew Project c·~nYJt:UE5I te! P-5ol5 

Qiien Project ... 
s.~ Proj.,ct locet ....... 

-
­

6.6 RUN 

After examining all input files, select operation model and check the calculation options, then click Run 

and Start to onset the calculation. There is an alerting window that displays on the screen while the program 

is calculating. 

6.7 OUTPUT WINDOW 

When the calculation is finished, the program unloods the INPUT Wm.low anl displays the OUTPUT Wm.low. 

"Child" windows are employed to display text reports, graphs for various calculation results. A "child" 

window is a window confined to its "parent" window - the OUTPUT window. "Child" windows can be 

displayed independently. The user can manipulate them just as normal windows: move, resize, close, etc. The 

arrangement commands in the Window Menu (Cascade, Tile, Arrange Icons) have the same functions as those 

of the Program Manager of Windows itself . 
.­
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There are six "child" windows within the OUTPUT Window. These windows display on the screen in 

the file fonnat automatically. They are: 

1. Equivalent Stress (static) - graph 

2. Hydraulic Pressure (static) - graph 

3. Axial Drag (static) - graph 

4. Surface Load (dynamic) - graph 

5. BHP (dynamic) - graph 

6. CSTRESS Data Report - table 

Use the mouse to click any of the "child" windows, then the "child" window becomes activated and the 

title bar background color changes. Only one "child" window can be activated at a time. The CSTRESS Data 

Report Window will show data for the graph in the active "child" window. 

-I Output I· I; I 

flle Window Help 

H draullc Pressure tau 

Equivalent Strrn Hydraulic Pressure Axial Drag 
I - ---••­ ,_ ,... ,..,., 

KJ). Mll. 

'"" 
KD. / ..1•1 I....., 1•1 1•1 

1­ 1­
I,,.,. - I rw. 1 ... .' • • ,,_.()sq 

-~ 
Surface Load BHP 

Surface Load s1r... .---------­ @7950.0 
1 0.0 

I""'' 
,_ 

2 100.0 
KD Mll. 3 200.0 
(kl 1•1 4 Dl_O 300.0

1­ 5 .eoo.o 400.0 
/!"""< & 500.0 500.0 

lop 
I rw. 7 600.0 600.0 

8 700.0 700.0 + 
S&#l.a.ofl.oaod[MJ Bol:.lol•PNUW•(J.Al + • 

Figure 6-19. Output "Child" Window 

6.7.1 Print Results 

To send results to the printer: I) activate the desired "child" window, 2) pull-down the File 

menu, and 3) click "Print Report/Graph Only." 
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-I Output 

Elle Window Groph Qptlon · l:lelp 


-I Output I· I~ I 
Elle Wlndaw Graph Qptlon .tielp I 

l!Tlnt Report/Graph only 
Print Profect flle 
Print WI and SDI Ale 
Print IOI and POI File 
!;opy Graph lo Clipboard 
Ji""" Report o;sk File 

Bade lo Input 

fxll 

-

-

.­

Figure 6-20. Pull-Down File Menu 

The user can print the input data by selecting "Print Project File," "Print WDI and SDI File," 

and "Print TDI and PDI File." If "Save Report Disk File," is selected, the data in the CSTRESS Data Report 

"child" window with/without TDI and PDI data will save to diskette. 

Copying the active graph to the clipboard can put the graph image to clipboard, and this graph image can 

be retrieved by certain window graphic programs, such as Window-Paintbrush. 

6.7.2 Manioulating the Outout Graph 

Under Graph Options - Image File Fonnat pull-<lown menu there are two types of graphic file 

formats: Bitmap and Metafile. 

Figure 6-21. Graphic Image File Format Selection 

One difference between Bitmap and Metafile is that Metafile is resizeable. After selecting Metafile 

and copy graph image to clipboard, open Windows Utility: Clipboard Viewer and change the size of the Viewer 

window. Graph size proportions itself to the window size. 

To enlarge the size of the graph in the OUTPUT Window: 

1. Activate the sub-window by clicking any where inside the window (the title bar of active sub­.- window is in color). 
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2. 	 When the mouse cursor is moved to the boundary of the sub-windows, 1he cursor becomes 

a double arrow (Figure 6-22). 

3. 	 Hold left button of mouse, then drag the boundary to the siz.e you want. 

4. 	 For a full-screen graph, click the maximiz.e box in the top-right corner of 1he sub-window. 

NOTE: It is impoTtant to change the size of the graph on the screen because the size of the 

prinled graph depends on the size of the graph on the screen. 

=I 
flle 

M.D. 
(fl) --

Output 

M.D. 
(fl) ... 

... 
/ ...... 

Axial Load(lbf) 
I"" 

llol loi. P1HN"• (Jd} 

Figure 6-22. Change Graph Siz.e 

If the user selects Window - Cascade from the pull-down menu, the "child" window (only the 

visible "child" window) in the OUTPUT Window becomes CASCADE. 
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-I 
file Window Graph Qpllon 

Output 
l:!•lp 

l·I: 

BHP IDvnomlcl I 
Surface Load lnvnamld I 

kdol Droo !Stolle) I 
"""roullc Pressure !Statlcl I 

Eaulv. Stra. !Stadel I 
-I 
E--.. 
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Data Report 
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llDsil 
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2 100.0 100.0 0.00 7595 5305 
J 200.0 200.0 0.00 7461 4871 
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I+ 

.-
Figure 6-23_ "Child" Window CASCADE 

6.7.3 Select Outuut Graoh Curves 

When the calculation is finished, all output graphs with whole set curves will display on screen . 

Not every curve is important to the user, so the program provides the option of presenting the desired curve on 

the graph. Select Graph Option - Curve Option pull-down menu, CSTRESS's Graphic Curve setting will 

display on the screen. 

Equivalent Stiess Hydraulic Pressure Axial Drag 

... 
Equjyolonl s-. H,m..........e - Lo+d (8...,.) S..toce Lo+d Botta• H• Pre. 

t&'.ll['!!!!.. 51••-il C8:J hllemal Pre. C!lJ S-0 (Log. I C!lJ Hook Lo+d iZl Bal. Hole Pro. 

IZl-sb... 181 ......... Pr•. 181 Yield Load t8J T-g Top t8:J Pme Pie. 

181Y...d Sh... 181 POfe Pre. t8J Sinu..,;d BU ~ F1acture Pie. 

~ 
18:1 Ftactwe Pre.. 181He&c.IBU 

K.D. 181 Somo Bltl.. 
1•1 

/ t•bbc 6 500.0 !illl.O 
lop 

/rw. 1 600.0 600.0 
e 7DD.O 700.0 + 

SWlacitl.Gld (llE) S:.:. lail• P1•11ft.. (Jlsil • • 

Figure 6-24. Graph Option - Curve Option Pull-Down Menu 
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Choose the desired curve by clicking the mouse at each check box (mark an x in each box), then 

click the OK button and the program redraws each graph. 

6.7.4 Bi-Axial Grauh 

To examine the bi-axial and API stress for each coiled-tubing section, pull-down the window menu 

and select Bi-Axial Graph. The Bi-Axial stress graph displays on the screen. 

Output ; 
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0·111111 

DD-1.!ilq"oo) 
ID- 1.232(;,,I 
T--- 0.1341;,,1 
E• 30000000bml 
Y-BOOOO(pal 

• 

Figure 6-25. Bi-Axial API Stress 

Depending on TDI input, the right-hand side of the program lets the user examine each input CT 

string section. NOTE: the TDI input program allows up to fifteen strings but only allows ten strings in this 

window. The numbers printed to the right of the string order number is the measure depth range of each section 

and shows string information at the bottom. 

Although the program shows triaxial stress calculation results on the Equivalent Stress (static) graph 

and in the CSTRESS Data Report, the biaxial stress criteria is still required here to draw the ellipse. The upper 

part of the ellipse is based on zero outside pressure and the lower part of the ellipse is based on zero inside 

pressure. The pressure data used to draw the inherited pressure-stress curve for each pipe section, are the 

difference between inside and outside pressure. If the inside pressure is greater than the outside pressure, the 

program uses the pressure difference to check the pipe in burst consideration. If the inside pressure is less than 

the outside pressure, the program uses the pressure difference to check the pipe in collapse consideration. For 

example, if the outside pressure is 4000 psi and the inside pressure is 1500 psi, the program uses 3000 psi ( = 
4000 - 1000) outside pressure and zero inside pressure to draw the pipe curve and the user can examine the 

biaxial and API stress in collapse. In Figure 6-24, the curve of the pipe is inside the curve of the biaxial and 

API which implies the pipe inherited stress is less than the yield stress. 
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Figure 6-26. Pump Equipment Window 

6.7.5 	 Pumo Equipment 

The tubing pressure data shown in the graph and output report are for coiled tubing that is inside -
the wellbore (i.e., below the BOP). For coiled-tubing operation, the mud pump is connected to the reel. Certain 

lengths of coiled tubing remain on the reel. When mud is pumped through the coiled tubing remaining on the 

reel, there is extra pressure loss on this section of the tubing. To calculate pressure loss and find the required 

output pressure and horsepower of the pump, pull-down the window menu and select PUMP EQUIPMENT. 

The PUMP EQUIPMENT Window displays on the screen. 

Most input data for the PUMP EQUIPMENT Window comes from previous input and output data. 

The user can edit any of the input data. After the input data are satisfied, click the calculate button and the 

output data is shown on the screen. Click the go back button and the PUMP EQUIPMENT Window is closed. 

6.7.6 	 Exit Output Window 

To leave the OUTPUT Window, pull-down the File menu, select "Back to Input." This takes the 

user rack 1o 1he INPUT Wmdow k> edit inp.rt dala, select "Exit" This exits 1he program and goes rack 1o MS Wmlows. 
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6.8 USING TORTUOSITY 

When the Survey Data Input (SDI) page is loaded into the INPUT Window and the survey data has been 

created, click the tortuosity command button and the TORTUOSITY Window displays on the screen. 

-I Input - fSurvey Data Input WindowJ l·I: 
[lie Model Page Bun Customer !J.tility l:!•lp 

C·\VR\CH\TEST SDI P-3 ol 5 

Unit 1:2!JYl;!ll"!i:!!J ~ ~ IDCJtn•I~ iYim!!!!l 
Qm!Jti e.nsn --. 

.-Dcpth;­ 1 0.0 0.00 0.00 .. 
@Feet 2 100.0 0.00 0.00 f ­

3 •oo.o 0.00 0.00 
Owntm • 800.0 0.00 0.00 

5 1200.0 0.00 0.00 
r-1nclina4ion: ­ 6 1600.0 0.00 0.00 

@ Dcciowtl 7 200tl.O 0.00 0.00 
B 2400.0 0.00 0.00oo... w;,, 
9 2800.0 0.00 0.00 

10 3200.0 10.00 0.00 + 

-~::1 [E~I 
insert Line licicte lb: 

I 

0 Di FIOld I 
I 

TortuozilJ... 

Figure 6-27. Tortuosity Command Button 

Figure 6-28. Tortuosity Window 
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.- At the top of the TORTUOSITY Window, there are two "child" windows: 1) Survey Data Table and 

2) Tortuosity Dogleg Graph. At the bottom of the TORTUOSITY Window is the data input area. 

The survey can be divided into as many as five zones (for example: surface to KOP, first build section, 

first tangent section, second build section, and second tangent section). Each survey zone may then be given 

a different amplitude for its distributed tortuosity. The bottom measured depth is always equal to the maximum 

survey depth. The period data is the length of one sine wave cycle. The user can input the desired tortuosity 

cycle. Sometime the survey data density is low and the user can click insert stations and the program imer1S more 
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Figure 6-29. Tortured Survey 

There are five command buttons at the bottom: 

1. 	 Calculate - tortures the original wellpath, and both the survey data table and dogleg severity graph 

shows the tortured survey. 

2. 	 Un-Do - resets the data to the original survey data. 

3. 	 Print <F6> - prints the active window. If a table or graph is displayed on the screen and the 

print command button cannot be seen, press the < F6 > function key to execute the print 

command. 

4. 	 OK - copies the tortured survey data to the SDI file in the SDI Input screen. 

5. Cancel - leaves the TORTUOSITY Window without any changes in the SDI data. 

Both tables and graphs can be enlarged. 
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-I Assistance 

For assistance with this program. contact: 

lee Chu 
or 

Gefei Liu 


Maurer Engineering Inc. 

2916 West T.C. Jester 
Houston. 1X. 77018 

LI.SA 

Phone: 713-683-BZZ7 
Fax: 71J-68H418 
Telex: 216556 

Figure 6-31. Help - Assistance Dialog Box 
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Figure 6-30. Tortured Survey Data and Dogleg Graph 

6.9 CSTRESS HELP AND DIALOG BOXES 


There are five types of dialog boxes associated with menus: Assistance dialog box, About dialog box, File 

Open dialog box, File Save dialog box, and Color dialog box. 

6.9.1 Helo - Assistance... 

When the user selects the "Assistance... " command from the Help menu in both INPUT and 

OUTPUT Windows, the following dialog box appears (Figure 6-31): 
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6.9.2 Help - About... 

When the user selects the ''About. .. '' command from the Help menu in both INPUT and OUTPUT 

Windows, the following dialog box appears (Figure 6-32): 

Figure 6-32. Help - About Dialog Box 

6.9.3 Ooen Project and Data File 

When the user selects the "Open Project" or "Open File" from the File menu in the INPUT 

Window, the following Open dialog box appears (Figure 6-33): 
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Figure 6-33. "Open Project" Dialog Box 

This dialog box enables the user to search the file system for the desired files with the extension 

".CDR." The extension name (.CDR, .WDI, .SDI, .CT4, .CP4, .DB, etc.) is chosen automatically by the 

program to determine the type of file that will be opened in the different windows. 

The user can move between sections of the dialog box by simply clicking on the desired section. 

Alternatively, the user can press the <TAB> key from keyboard until the focus moves to the desired section. -
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There are four list boxes: the drive list box, the directory list box, the file list box, and type list 

box. Their :fuocliom are descnbed below. There is ore 1eXt box am Mi COllll1lllld buUorl;: OK am CANCFL. 

1. 	 The Drive List Box 

On the lower right corner is the drop-down drive list box. In its normal state, it displays the 

current drive. When the user clicks the arrow at the right of the drive list box, it drops to list 

all valid drives. The user can activate a new drive by single-clicking the desired one. 

2. 	 The Directory List Box 

The directory list box displays the hierarchy of paths of the current drive. The current 

directory appears as a shaded, open-file folder; directions above it in the hierarchy appear as 

a nonshaded open-file folder, and those immediately beneath the current directory are closed­

file folders. The user can change the directory by double-clicking the selected one. Note that 

in the directory list box, a single click only selects (highlights) the item; a double click is 

required for the command to be perfonned. 

3. 	 The File List Box 

The file list box displays the files in the current directory. The file names shown are those 

specified by their extension name ''CDR.'' A single mouse click on an item makes it appear 

in the "File Name" text box. If the user chooses OK at this time, the data file is retrieved 

and all data related to the current calculation mode are displayed in appropriate entries. 

Double-clicking the selected file has the same effect as above. 

When the user selects a new drive, the directory list box is updated, which then causes the 

file list box contents to be updated. When a new directory is selected, the file list box is 

updated, but the drive remains the same. 

The path specification label always represents the current path information. 

4. 	 The Type List Box 

This list box is set by the program. The user cannot change it. It specifies the type of files 

that are to be displayed in the file list box. In this "Open Project.." dialog box, the type of 

file is "*.CDR." 

5. 	 "File Name" Text Box 

The application should also do the following when the user enters text in the "File Name" 

text box and then presses < ENTER > . 

• 	 If a drive letter is entered, 1he drive, directory' am file list boxes shook! be updated. 

• 	 If a directory path is entered (for example, "\CSTRESS"), the directory list box 
and the file list box should be updated accordingly. 

• 	 If the name of an existing file (with extension name ".CDR") is entered, the 
dialog will be completed and the files will be retrieved. 
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6. Command Buttons 

If the existing file name is shown in the text box, pressing OK will complete the dialog and 

the data file will be retrieved and displayed. 

If the CANCEL button is pressed, the dialog is cancelled and no information is made 

available to the application. 

6.9.4 Save Project - Data File 

When the user selects "Save Project As" or "Save File As" commands form the File menu in 

the INPUT and OUTPUT Windows, the following dialog box appears (Figure 6-34): 
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Figure 6-34. "Save File" Dialog Box 

01:. 

c:.nc.1 

This dialog box is almost identical to the "Open Project" dialog box in appearance; however, the 

.- filter in the type list box is different. Depending on the file the user is manipulating, the filter in the type list 

box will be a ".CDR," ".WDI," ".SDI," ".CD4," or ".DB," etc., extension. 

6.9.S ~ 

When the user selects one of the commands on color from the Customer Utility menu in the 

INPUT Window, the following dialog box appears. 
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 Figure 6-35. Color Dialog Box 

The Color dialog allows the user to select a color from a palette or to create and select up to 

sixteen custom colors. 
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6.10 CSTRESS ERROR HANDLING 

When input data on a page are outside the appropriate range of values and the user tries to leave the page, 

the CSTRESS error checking routines will locate the error. The application will then display an error message 

explaining why the data are not acceptable. The user can ignore the error message and leave the page even 

though the data on the page do not make sense. This enables the user to edit and view different input pages 

without having to complete one before going to another. 

The user can start calculation from any page. If any invalid data are found at this time, the application 

will display an error message and force the use to go to the page with invalid data for editing. 

When an error message appears, click OK or press <ENTER> to return to the associated page in the 

INPUT Window. 

6.11 QUICK START 

Use the following procedure to get started with the CSTRESSl program. 

Install: 

1. 	 Start Windows (3.0 or later version). 

2. 	Insert Disk into drive A:. 

3. 	In the File Manager, choose Run from the File menu. 

4. 	Type A:setup and press Enter. 

5. 	Follow on-screen instructions. (Please use the default subdirectory). 

Run: 

6. Double-click the CSTRESSl icon. 

7. In the first window (INTRODUCTORY Window), click "Continue" after it becomes responsive. 

8. In the INPUT Window, choose "Open Project. .. " from the File menu. 

9. 	From the "Open CDR File" dialog box, click the drive C: in the drive list box, double-click the 

"CSTRESS" subdirectory, click the "TEST.CDR" in the tile list box, and then click OK. 

10. Click "Next" from the Page menu to view other pages of input data (WDI, SDI, TDI, PDI). 

11. Click the "Start" from the Run menu. After calculation the OUTPUT Window is loaded. 

12. In the OUTPUT Window that follows, select the text report or interested graph windows under the 

"Window" and "Graph" options of the menu to view the output. 

13. To print the text report or graph, make the corresponding "child" window active, select "Print 

Report/Graph Only" from the File menu. 

14. Choose 	"Back to Input" from File menu to return to the INPUT Window or choose "Exit" to 

terminate the application. 
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8. BUG Report or Enhancement Suggestion Form 

- Name: Company: 
State: ____Addr~: City: 


Phone No.: Fax No.: Date: 


D Bug\Problem Report D Enhancement Suggestion 


Program Name and Version Number: 

Bug\Problem Description or Enhancement Suggestion: 

Regarding the Bug Report, please answer the following questions: 

Computer System Brand: 

Chip: 0 286 D 386 D 486 D Pentium 

Type: D Desktop D Laptop D Notebook D Other 

RAM: MB Sw!l: MHz 
- - Math-Coprocessor Present: D Yes D No D Unknown 

Printer Type: (for printing error only) 

Plotter: (for plotting error only) 

Within Network System: D Yes D No Type: 

Video Type: D EGA D VGA D SVGA D Mono D LCD 

Video Card Ram: _______ (video problem only) 

Operating Svstem 

MS-DOS Version No.: MS-Windows Version No.: ____(forWindowsapplications) 

OS2 MS-Windows NT Version No.: 

0ther 

BUG Detecting Data 

[] Will be mailed on diskette D Will be faxed D Attached D None 

Other Comments: 

- Please send or fax to: 
Lee Chu 


MAURER ENGINEERING INC. 

2916 West T.C. Jester 


Houston, TX 77018-7098 

Ph.: 713/683-8227 • Fax: 713/683-6418 
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